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Managementuittreksel 

Titel GES User's Guide version 1.05 
Auteur ir. J. van Vugt 
Datum 15 december 1997 
Opdrachtnr. A96/KM/148 
IWP-nr. 792 
Rapportnr. 96-CMC-R0274 

Met het oog op de komst van nieuwe voortstuwingssystemen heeft de Koninklijke Marine behoefte 
aan een rekenprogramma waarmee verschillende mogelijkheden voor de energieopwekking en 
voortstuwing van een schip doeltreffend kunnen worden vergeleken met betrekking tot een groot 
aantal voor de Koninklijke Marine van belang zijnde aspecten. 
Dit rapport is de handleiding van het rekenprogramma. Het rekenprogramma heet Gei'ntegreerde 
Energiesystemen, afgekort GES. Met dit programma kunnen verschillende energiesystemen aan 
elkaar gekoppeld worden. Daarvoor zijn een aantal afspraken gemaakt, hoe een specifiek systeem, in 
GES apparaat genoemd, opgebouwd moet worden. Gekozen is voor een voorstelling op energiebasis. 
Door de vermogensuitwisseling van een apparaat naar zijn omgeving uit te drukken als het product 
van twee variabelen is het mogelijk apparaten gemakkelijk te koppelen. Men kan zieh door deze 
werkwijze concentreren op een apparaat, zonder dat men direct rekening behoeft te houden met 
andere apparaten in het systeem. 

GES rekent stationaire Systemen door. Doordat er terugwerking van de omgeving op een apparaat 
uitgeoefend wordt, kunnen er algebraische lussen ontstaan. Dit wordt uiteindelijk wiskundig tot uiting 
gebracht in een stelsel niet-lineaire vergelijkingen. GES lost dit stelsel iteratief op. 

Het programma bevat een bibliotheek waar specifieke apparaten voor de Koninklijke Marine 
ingebouwd zijn. Tevens bevat deze bibliotheek enkele standaard apparaten waarmee een model 
opgebouwd kan worden. In de bibliotheek bevindt zieh een speciaal apparaat, de user defined 
apparatus waarmee men een eigen apparaat kan schrijven. Het is mogelijk met dit apparaat een eigen- 
apparatenbibliotheek te bouwen, door deze te verzamelen in een eigen model. 

pYiQ QUALHY rn'OPEOTSI 
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1 Introduction 
GES is a computer program for simulation of various energy systems. GES integrates a powerful 
library with a 3D-graphical pre- and post processor. 

The name GES is an abbreviation of the Dutch 'Gei'ntegreerde Energiesystemen'; translated: 
Integrated Energy Systems. GES is specially written for the Royal Netherlands Navy to calculate 
energy flows in ships, in the pre-design phase. A special library is incorporated for maritime systems. 
For general purposes all kind of energy systems can be simulated. 

The program GES is written in C++ with object oriented modules. The most important feature of 
GES is that it is easy to extend. The versions l.## of GES can only simulate stationary systems. It is 
possible to write a user defined stationary system library. 

If you are a new GES user, you should start by reading 1.2 Overview of GES, page 7. The most 
important things to learn are how to choose energy directions and how to choose the output gate 
functions. After you master the basics, you can continue with 1.6 Quick start, page 11 and later by 
Building a simple model, page 196 in the tutorial chapter in this guide. If you are familiar with 
building your models by using the import library apparatus, you could start making a user defined 
model. In the tutorial Example: ideal electric transformer, page 207 you could leam how to make 
your transformer. 

1.1 Purpose of GES 

The purpose of the computer program GES is to facilitate, during the pre-design stage of a 
naval vessel, comparisons of different systems for propulsion and electricity generation, 
concerning a number of important items: 
- energy consumption and efficiency of the ship as a whole; 
- pollution through engine emissions; 
- heat emissions in air and water (in view of infrared detection); 
- dimensions of the installations (in view of required volume); 
- weight of the installations. 

It should be noted that originally these items also incorporated: 
- sound and vibrations on board; 
- emissions of sound in air and water. 

However, these items could not be simulated with the same model as required for the energy 
analysis. It was concluded that it was better to analyze these items by means of separate, 
specific computer programs. 

Some typical applications of the program GES are: 
- analysis of highly integrated and interdependent propulsion and energy systems on board 

naval vessels; 
- determination of benefits and drawbacks of new types of systems; 
- optimization of propulsion and energy systems; 
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-   determination of the residual capacity of a ship in case of malfunctioning of certain 
installations (which missions can still be performed?). 

1.2 Overview of GES 

In GES two types of apparatuses are possible: energy apparatuses and signal apparatuses. Energy 
apparatuses are used for building a model of a physical system. Signal apparatuses are used to control 
the energy apparatuses. 

1.2.1 Energy apparatus 

An apparatus in GES has the property that each gate is associated with a (scalar) power flow 
expressible as a product of two variables. However, in the actual analyses, power needs not to be 
expressed as a product of two variables. For the class of GES apparatuses it is common practice to 
split the power into particular factors that can easily be measured and that can be given physical 
interpretations. In general discussions it is convenient to give the names effort (symbol e) and flow 
(symbol/) to the two factors and to define the power (symbol P) as follows: 

P = e.f 

In principle, these variables can be functions of time, but in the versions l.## of GES only stationary 
expressions between the variables are considered. 

In Table 1 some common physical variables are listed and it is indicated which variable will be 
considered to be an effort quantity a which will be taken to be the flow quantity. 

Domain Effort Flow 

Mechanical translation Force F [N] Velocity V [m/s] 

Mechanical rotation Torque M [Nm] Angular velocity a> [rad/s] 

Hydraulic Total pressure p [N/m2] Volume flow rate Q [m3/s] 

Electric Voltage U [V] Current / [A] 
Chemical Chemical potential ß [J/mol] Molar flow N [mol/s] 
Thermodynamic Temperature T [K] Entropy flow S [W/K] 
Thermodynamic 
(stationary) 

Specific enthalpy h [J/kg] Mass flow m [kg/s] 

Table 1 Physical effort and flow variables 

A number of comments in Table 1 are in order. First, efforts and flows should not consider to be 
scalar quantities although a vector force F acting on a material point with vector velocity V has an 
associated scalar power. 
If the power flow is split into two variables, the direction of the power flow must still be considered. 
If two apparatuses are connected, the power flow out of one apparatus is the power flow into the 
other. The variables are so arranged that, if both effort and flow have the same sign, the energy flow 
flows into the apparatus. This is as clearly with conventional notations. In the GES notation this is 
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indicated by a half arrow at the end of the connection line. Figure 1 shows an example of the general 
model structure of the apparatuses in GES. In principle all apparatuses are identical. They are filled 
with different functions to describe a physical system. On each gate only one function is possible. 
This could be an effort function or a flow function. To make a connection it is required that the 
energy directions of the gates are different, just as the effort and flow functions. GES gives a warning 
if the user tries to make a connection with wrong conventions. 

U F effort T *                                * 

r                           \ 

Hin              / 

flow 
/ 

CO / 

/ 

V 

/ 

1 

/ 

/ app3 

: 
-   app4 

/ app2 
i '  

"out 

appl / 

T=fi(co, V) F=f2(co, V) V=h(F,l) U=U(F,I) 

Figure 1   General model structure in GES 

The example in Figure 1 contains four energy apparatuses: appl, appl, app3 and app4. In appl two 
apparatuses are defined: app2 and app4. In app2 is one apparatus: appS. The last apparatus in the 
path contains the effort and flow functions. Apparatuses covering one ore more other apparatuses are 
called in GES mantle apparatuses. This example contains two mantle apparatuses: appl and appl. 
Apparatus appl and app4 are connected. Apparatus appl calculates the effort F with function f2 and 
apparatus app4 calculates the flow V with function f3. 

In GES the effort text is written in red above the half arrow and the flow text is written in green under 
the half arrow. If the variable is a function then the text is written to the end of the half arrow. If the 
variable is an argument then the text is written near the apparatus. For the user defined apparatuses it 
could be that there is no function defined. In that case a black zero is written to the end of the arrow. 

The import library apparatuses have all the effort and flow functions default in memory. With the 
user defined apparatus it is possible to make these functions oneself. 

Introduction 
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Trough this structure in GES it is possible to insert new apparatuses or even complete model 
structures. 
GES sorts the functions before they are calculated. The results could be a collection of implicit 
functions and/or a set of explicit functions. See also Solution principles, page 164. 
GES tries to calculate every function if a calculation is possible. Therefore more than one model can 
be calculated in one run. 

1.2.2 Signal apparatus 

In GES most signal apparatuses have one gate. The energy variable flow is used as a signal function 
value. The signal apparatuses have a priority in running. The pre-types are running before the energy 
apparatuses and the pro-types are running after the energy calculations. Some signal import 
apparatuses have a special priority to run, they are sorted automatically by GES. 
If a signal apparatus is connected to an other apparatus the visible connection is made in the origin of 
the apparatus or on the connected gate of the apparatus. For instance the epi apparatus in Figure 2. 
The epi apparatus is connected at the Diesel in the (local) origin of its figure. 

Figure 2  Example connection of signal apparatus 

1.2.3 Apparatus structure 

In GES all apparatuses have an identical object structure. For every apparatus is chosen: 
- the number of gates. 
- the number of parameters 
- the effort or flow function of a gate 
- a local workspace 
- a parser string (this is a text string for the equations). 

The number of gates is depending on the energy interaction with the surroundings. The number of 
parameters is depending of the apparatus type. The effort and flow functions of a gate are depending 
on the available function who must describe the variable. It is possible that both effort and flow 
functions could be expressed. In that case more apparatus descriptions are possible. 
In the local workspace some variables can be set. These variables are visible for the user in the results 
mode. In the parser string some special functions (parser functions) can be set to perform operations 

Introduction 
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with the workspaces and the parameters of the apparatus. The parser string is specially used by the 
user defined apparatus, but it is possible that the user uses the parser string for comments (e.g. for 
import library apparatuses) and startup low-level initialization calculations. 

In GES two special global workspaces are available: the system workspace and the global workspace. 
All apparatuses in the model can use these workspaces. With the global workspace it is possible to 
exchange variables with other apparatuses which are not connected in one model. Global workspace 
variables are marked with an exclamation mark (for instance: !A). 

With the system workspace the user can also exchange values with separated models which are 
created with New. The system workspace gives information about the calculation errors and 
calculation flow in special reserved variables. The system workspace variables are marked with two 
exclamation marks (for instance: üerror). 

1.3 System requirements 

GES requires: 
- MS-DOS® version 5.1 or later; 
- Microsoft® Windows™ version 3.1, support for 386 enhanced mode and WIN32 applications; 
- Windows 95 (some called Windows 4.0); 
- a personal computer with the Intel 80486 or Pentium processor and 4 megabytes or more of 

memory; 
an 80387 math coprocessor (of coprocessor intern by the other processors); 
a hard disk with 8 megabytes of free disk space; 
a monitor that is supported by Windows; 
a mouse that is supported by Windows, recommended is to define a doubly click button; 
a printer that is supported by Windows. 

1.4 GES directory structure 

GES is distributed in compressed format on a diskette. The installation procedure moves the files on 
this disk to the hard disk, decompresses them, and installs them in the Windows environment. 
After installation, the GES directory will posses the following files and subdirectories. 

\GES The GES binary and associated files 
\GES\DATA The data work directory 
\GES\EXAMPLES The example model directory 
\GES\MODEL The default user model directory 

1.5 Installation instructions 

See the GES installation Disk. 

1.5.1 Windows 3.11 

Introduction 
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After installation the user can set the program GES in a program group. First, select the group (e.g., 
Applications), then you must select the New option of the File menu. Choose Program Item and click 
on OK. The Program Item Properties dialog box must contain: 

,^p';   ■*• :"r* Program Item Properties lii§llll§il§l§llifliiiil|§ 1 

f  Description: 

|  Command Line: 

1 Working Directory: 

|  Shortcut Key: 

1      W 

P 
B OK i 
c: \ges\geswin. exe Cancel 
c:\ges 

firowte... * 
None 

EH Run Minimized Change Icon... 
1 

Kelp 
^..™W^W™^W.W™,^TOWWW, „ j 

If you click on Change Icon the internal icon of GES is displayed. 
The GES icon is: 

H 

1.5.2 Windows 95 

Create a short cut by clicking on the right mouse button in the desktop area. Click on New and select 
Shortcut. Browse to the GES program executable GESWIN.EXE and finish the procedure. 

1.6 Quick start 

If you would like to start GES quickly, this section describes a short series of actions you can take to 
get going. 

1. Start up GES in Windows by double-clicking the icon GES or run GESWIN.EXE in the GES 
directory. The last model could appear if this is set into the GES.INI file. 

2. Select New in de pop-up menu File. A new GES window will appear. 

3. Select Benchmark in de pop-up menu Simulation. A simulation model of a propulsion 
installation will appear. 

4. By clicking on Start in de pop-up menu Simulation you can start a simulation by Run. 

5. If you click on Result mode under the header menu Simulation the cursor is set in the 
results mode. If you click on a gate of an apparatus the results of that particular chosen 
apparatus are displayed in a dialog box. 

Introduction 
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6. You can adjust the parameters of your model by selecting Parameters values from the Edit 
menu. With the mouse cursor you select the apparatus. 

7. In section 2.1 Object manipulation, page 15 more features are explained for manipulation of 
the model. 

1.7 What is new in GES version 1.05 

This section summarizes the changes and enhancements that have been incorporated into GES 
version 1.05 with respect to the previous version 1.04. The most important changes are: 

System workspace 
The global workspace is coupled to the highest apparatus in the apparatus tree. This is the 
mantle apparatus of the new window. In GES it is possible to open more than one new 
models. In version 1.05 it is no longer possible to exchange values with the global workspace, 
because every model has its own global workspace. For changing values between new models 
the user can use the system workspace. 

Failure module 
A failure module is developed to calculate the probability of failing of the installation or a 
part. The user can use more than one failure module and define his own probability variable. 
The method is based on the 'fault tree analysis'. An apparatus with one input gate is present 
as an AND function and an apparatus with more than one input gate is present as an OR 
function. Apparatuses inside an apparatus are present as an OR function. 

Log file 
A log file can be used for information of the GES program. This file is closed after the GES 
program is stopped. 

Initialization file 
An initialization file (GES.INI) can be used to set up the system variables of the GES 
program. The user can define his own environment by changing the settings under the section 
names. There are eight sections names: [window], [directories], [files], [programs], [tools], 
[iterations], [plotlayout], [timevalues]. Each section has his own settings. See Appendix A 
Initialization file GES.INI, page 211. 

Introduction 
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1.7.1 System workspace 

In GES version 1.05 the system workspace is introduced. The system workspace is used for error 
reporting and calculation flow reporting to the user. Experienced GES users can optimize the user 
apparatus by using the default system workspace variables: 
• !! error 

This variable is used to give the user information if there is an error encountered in the calculation 
process. 

• üstep 
This variable is used to give the user information of the actual process step. The first step value is 
0 and the last step value is (!!nr_steps-l). 

• !!nr_steps 
This variable is the total number of steps in the calculation process (foreground). 

• üflag 
This variable gives the user information about the state of the calculation process. The flag values 
are: 

pre-calculation 
parameter iteration 
parameter iteration and normal iteration 
normal iteration 
normal calculation or initialization calculation (for time version of GES) 
time calculation (for time version of GES) 

It is possible to define your own global workspace variables. 

1.7.2 Error message 

If there is a calculation error encountered, the global system variable ! [error is set to 1 and the 
calculation process is stopped. The error message is written in the list box of the start simulation 
dialog box. The error message is also written in the log file. The user can set the system error variable 
with the user defined apparatus, however the calculation process is not stopped. 
If a foreground calculation process is started the error variable is set to 0. This holds for every step. 
By a background calculation process the error variable is also set to 0. 

1.7.3 Warnings 

Most warnings in GES are given by the parser for the user defined apparatuses. A warning does not 
stop the calculation process but there could be wrong results. The warnings are written in the log file 
of GES. 

1.7.4 Initialization file 

GES uses for start-up the initialization file GES.INI. See Appendix A 

Introduction 
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Initialization file GES.INI, page 211 for the description. 

1.7.5 Log file 

The log-file gives information about GES after the program is closed. Maximum 9 log-files can be 
used for history purposes. In the GES.INI file under section name [files ] you can set the number 
of log files behind logf ilenrs= and the log name behind log=. 

[files] 
logfilenrs=0 
log=C:\Ges\ges.log 

In the log-file is set: 
• The time of starting the GES program. 
• The opening model file with the name of the GES version. 
• The apparatuses which are calculated 
• The iteration error. 
• The last calculated apparatus if there is an error. 

A typical log-file is: 

Program GES Running from time: Wed Oct 08 16:05:45 1997 

open file: C:\Ges\MODEL\Asyaand.mod GES version:  1.05 
calculation apparatus: asynchrone aandrijf 
open file: C:\Ges\MODEL\Hyd.mod GES version:    1.05 
calculation apparatus: asynchrone aandrijf 
calculation apparatus: asynchrone aandrijf 
iteration error: par-functions != set-functions 
last calculated apparatus: diesel ,gatenr: 1 

Introduction, What is new in GES version 1.05 
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2 Graphical interface 
The GES graphics system provides a variety of tools to manipulate the models. The representations of 
the models are in 3D. Results of the calculations with more than one step can be presented in 2D- 
plots. Therefore a special window is available. See 2.3.6.4 Set Plot window (Simulation menu), page 
45. 
This section describes the menu functions implemented for the GES Window. 

2.1 Object manipulation 

2.1.1 Cursor modes 

The mode of the cursor depends on the requested action in the Edit menu or Options menu. There is 
no real cursor shape or message to show the active mode. In the Options menu a check mark 
indicates the last cursor mode. A option not in use is grayed. 

The cursor modes are: 
• Select (default) 
• Parameter values (set in Edit menu) 
• Equations (set in Edit menu) 
• Gate energy (set in Edit menu) 
• Connect (set in Options menu) 
• Disconnect(set in Options menu) 
• Disconnect (set in Options menu) 
• Mantle (set in Options menu) 
• Dismantle (set in Options menu) 
• Parameter setup (Simulation menu) 
• Results mode (Simulation menu) 

The cursor is set in the default select mode by clicking in the free space. 

2.1.2 Select apparatus 

To select an apparatus, click on one of the gates. This may be the beginning or the end of the gate 
vector. If the selection succeeds, the selected apparatus is written with a dot line. You deselect the 
apparatus by clicking in the free space (not a gate vector). The name of the selected apparatus is 
written in the status bar. 

Graphical interface, Object manipulation 
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2.1.3 View of the model 

- By pressing on the Home key the model is drawn in perspective. This is the default drawing mode. 
- With the left and right arrow keys you can move the model horizontally and with the up and down 

arrow keys you can move the model vertically. 
- If you press on the F7 key the model is projected in the y-z area; x-axis points out of the screen. 
- If you press on the F8 key the model is projected in the x-z area; y-axis points out of the screen. 
- If you press on the F9 key the model is projected in the x-y area; z-axis points out of the screen. 
- If you press on the INS key the model is zoomed out. 
- If you press on the SPACE bar the model is zoomed in. 

Using the mouse: 
- If the Fl key is hold down, the model is moved with the mouse cursor. 
- If the F2 key is hold down, the model is zoomed out if you move the mouse down. The model is 

zoomed in by moving the mouse up. 
- If the F4 key is hold down and the mouse is moved down the model is rotated positive around the x- 

axis. 
- If the F5 key is hold down and the mouse is moved down the model is rotated positive around the y- 

axis. 
- If the F6 key is hold down and the mouse is moved down the model is rotated positive around the z- 

axis. 

2.1.4 Move and copy the apparatus 

An apparatus can be moved and or copied by using the mouse. If you select an apparatus and hold 
down the left mouse button you can drag the apparatus to an other location. If you choose an other 
projection (press the F7, F8, F9 key) you can drag the apparatus in an area (y-z, x-z, x-y). 
If the original position of the apparatus and the target location are within the same window, the 
apparatus is moved. Any lines connected to the moved apparatus are redrawn. 
If you drag an apparatus in a different window, the apparatus is copied. A copied apparatus is a free 
apparatus and does not have connections to other apparatuses. All apparatuses inside the apparatus 
are also copied. 
If you move an apparatus in the same window and you press the <Ctrl> key the apparatus is copied. 
A selected apparatus is also copied if you click on copy in the Options menu. 

Graphical interface, Object manipulation 
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2.2 GES MDI window 

The GES window has a Multiple-Document Interface, or MDI, for managing multiple windows or 
views associated with a single application. Within the MDI client window GES windows are 
displaying the model structure. You can control the GES windows with menus in the MDI client 
window. If you start GES and no model is present a typical menu structure is: 

The File menu contains items to open a new model structure or to exit the program. 

i®pfe}ii< 

Save 

* Save a* 

: Save esASD!; 

Save data as ASDI 

Save mode) a« VRML 

Print: 

Exit 

The Window menu contains disabled items to arrange the GES windows. The functions are 
automatically enabled if they are useful. 

The Help menu contains items to help the user. 
The help index is not implemented. 
About GES shows information about 
the program GES and the system. 

Graphical interface, GES MDI window 
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About displays the following information window: 

1 About GES                                                   Ü 

GES(win32appii<Mtion} 

FD&                V«sion1.u5 

" •            Integrated Energy Systems 

flight 1994,1997 

Centre for M echanical Engineering 
P.O. Box 49 f—Dk—1| 
2600 M Dett, The Netherlands   ° 
AB R^jht» Reserved System Info! 

The following system information is displayed: 
  j-jwiwtfiijwrg^ ^M7} Ges System 

Windows version 4.0 
Percent memory in use 81 
Free physical memory 2340 KB 
Free virtual space 2071616 KB 
Keyboard 4 

The Windows version (4.0 is Windows 95). 
Percent memory in use. Present a number 
between 0 and 100 showing current memory 
utilization, in which 0 indicates no memory 
use and 100 indicates full memory use. 
Free physical memory. Indicates the number 
of bytes of physical memory. 
Free virtual space. Indicates the number of 
bytes of unreserved and uncommitted 
memory in the user mode portion of the 
virtual address space of the calling process. 
Keyboard number. 
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2.3 GES menus 

The GES Windows menus are shown below. 

[fieEs 
File   Libraiy   £dit   Options  Simulation   Tool«   Style  Window   Help 

• The File menu contains items to open and save model structures. 
• The Library menu contains entries to sub-libraries. In this guide this library is named the import 

library. 
• The Edit menu items allow to apply editing functions to apparatuses. 
• The Options menu allows building a model. 
• The Simulation menu allows to start the simulations and to analyze the results. 
• The Tools menu contains entries to start other programs. 
• The Style menu items allow to update the figures. 
• The Window items allow to arrange the windows. 
• The Help menu shows information about the program GES. 

2.3.1 File menu 

Open 

S_av« 

Saves3 

Savea$A,SCIi 

Save data as ASCII 

Save model a$ VRML 

Print 

Exit 

New creates a new system. 
Open selects a model to load from disk. 
Save writes the model to file, using the same file name. 
Save as writes a model to a new file. 
Save as ASCII writes a model to an ASCII file. 
Save data as ASCII writes result's data to an ASCII file. 
Save model as VRML writes model as VRML file. This is not 
correct implemented. 
Print prints the contents of the window on the current printer. 
Exit stopped program GES. 

Graphical interface, GES menus 
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2.3.1.1 New (File menu) 

New opens a new window called "New" in which you can create a new system. You use this 
command if you want to separate models. By opening "New" is empty. The first apparatus you create 
is the mantle apparatus of your new model. The mantle apparatus is not visible. Your mantle 
apparatus is as the border of the model. The name of the mantle apparatus is set in the window 
caption. All the following created apparatuses are incorporated in the first created apparatus. 
In the original of the coordinate system an arrow shows the orientation of the coordinate system. In 
the GES.INI file you can set the world coordinates. 

Graphical interface, GES menus 



TNO-report 
96-CMC-R0274 

GES User's Guide version 1.05 Date Page 
December 15, 1997 21 

2.3.1.2 Open (File menu) 

! File name: 
.mod 

a. mod 
a2f500.mod 
a4vsg.mod 
aes11.mod 
aes16.mod 
aes2.mod 
aes3.mod 
aes31.mod 

List files of type: 

I model Files (*.mod) 

folder«: 

cAges\MODEL 
OK 

Cancel 

Network...   1 

m 
Dr&e*: 
Sc: 3 

Open displays a dialog box with a list of existing files from which you can select the file you want to 
insert in the system. You can list the contents of a different directory by changing the path in the drop 
list Folders. You can view more file names by moving the horizontal scrollbar up or down. You can 
select a file by double-clicking on the name or by clicking on the file name and then clicking on the 
Open button. The default file type has the extension .mod. You can use other extensions. 

Graphical interface, GES menus 
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Save model in file 

C:Sg«$2&)\model\projectmod 

jfloi 

Save displays a dialog box with the name of the already opened file of the model. If the existing 
model is not opened from a file, the Save as dialog box is displayed. By clicking on the Yes button 
(or Enter key) you can save the model in its current name. 

2.3.1.4 Save as (File menu) 

Save model as 

Filename: 

l?|xj 

project), mod 
I Folder*:. ■;.. 
C:\ges20uAinodel 

QIC 

project, mod 
prop, mod 
resis.mod 
signal, mod 
synaand.mod 
testl .mod 
timejb.mod 
troi emi.mod 

ÜcA 
f| ges200 
f|§ model 

Cancel 

Network...   j 

'•■ Save tile a* tope: i Driver: 

I model Files (*.mod)       jjj       I S c: 3 
Save as displays a dialog box in which you specify the name of the file in which to save the contents 
of the model. You can save it to its current name or enter a new name. You can also change the 
directory in which it is to be saved. When Save is chosen for an import library built model, the Save 
as dialog box is also used. 
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2.3.1.5 Save as ASCII (File menu) 

You can save your model in ASCII format. This item is not worked out. It is not possible to read this 
format. This option is for future applications. 

2.3.1.6 Save data as ASCII (File menu) 

Save model as ASCII nm 
file name: fpfder*: 

c:\gss\data i 
OK 

Üc:\ 
flge* 

Cancel 

Network... 

Save file as lype: Drives: 

I ASCII model File* [Mxt)jj|]       Isc: Hi 

Save data as ASCII displays the Save as dialog box with files with extension .txt of the \ges\data 
directory. By clicking on the Save button the calculated data of all apparatuses are saved in an ASCII 
file dat.txt. 
The data file has the following structure: 

"name" the name of the apparatus between quotation marks 
"# gates " value text # gates between semicolons, value is the total number of gates 
" gate" value text gate between semicolons, value is the gate number 

e" value   [-] effort name between semicolons (e is default), effort value, unit 
symbol ([-] is default) 

II                                                          H value   {-] flow name between semicolons (f is default), effort value, unit 
symbol ([-] is default) 

power" value   {W] power between semicolons (power is default), value, unit symbol 
([W] is default) 

"   dissipation" value   [-] dissipation between semicolons, value, unit symbol ([-] is default) 
efficiency" value   M efficiency between semicolons, value, unit symbol 

empty line 
"name next" next apparatus results between quotation marks 
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Example: Propulsion apparatus with two apparatuses name Resis. and 
Trans. : 

Propulsion installation" 
# gates " 
gate " 

gate " 

Resis. " 
# gates 
gate " 

Trans." 
# gates 
gate " 

gate " 

2 
0 

e" 0.000e+00 '-] 
f" 0.000e+00 ;-] 

power" 0.000e+00 
1 

.—] 

e" 0.000e+00 .-] 
f" 0.000e+00 '-] 

power" 0.000e+00 -] 
dissipation" 0.000e+00 :w] 
efficiency" 0.000e+00 

1 
0 

F" 0.000e+00 .-] 

vs" 0.000e+00 -] 

power" 0.000e+00 -] 

dissipation" 0.000e+00 W] 
efficiency" 0.000e+00 

2 
0 

mo" 0.000e+00 -] 
wo" 0.000e+00 -] 

power" 0.000e+00 
1 

— ] 

mi" 0.000e+00 -] 
wi" 0.000e+00 -] 

power" 0.000e+00 -] 
dissipation" 0.000e+00 W] 
efficiency" 0.000e+00 -] 
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2.3.1.7 Print (File menu) 

IrPtMw-- 

Mama! HP LaserJet 4Si/4SiMXPS J7J £roperfies 

Statut: Default print«; Reacjy 

Types HP U*erJet 4S1/4SJMK PS 

Where: \W2Shpfe*er-21 

Comment: V Print to f|e 

p Print range  

& A* 

C Pages   {ram: [3 

<~ Selection 

italffl 

^Copie«i 

of copies:     |1      *|j; 

OK       |       Cancel 

Print displays a dialog box of the installed printer. By clicking on the drop down box you can change 
the printer. If you want to print your graphical model you must click on the OK button. 
See for changing the print size 2.4.1 Plot layout, page 54. 
If you click on Properties you can change the printer settings. 

Graphical interface, GES menus 
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2.3.2 Using the Windows Clipboard 

You can move information between GES and other applications using the Windows Clipboard. To 
transfer a plot of a Window application to another application, use the Windows key sequence ALT- 
Print Screen to copy information to the Clipboard from the active window. Then, invoke the other 
application (or make the other application's window the active window), and select the Paste 
command from it's Edit menu to past the contents of the Clipboard to the active window. 

Graphical interface, GES menus 
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2.3.3   Library menu 

Electric ► 

| Mechanical ► 
Hydraulic > 

Thermodyrx ► 

Maritime ► 
Elements ► 
Component* ►"] 

General is a sub-library to general apparatuses. 
Electric is a sub-library to electric apparatuses. 
Mechanical is a sub-library to mechanical apparatuses. 
Hydraulic is a sub-library to hydraulic apparatuses. 
Thermodyn. is a sub-library to thermodynamic apparatuses. 
Maritime is a sub-library to maritime apparatuses. 
Elements is a sub-library to element apparatuses. 
Components is a sub-library to ideal apparatuses. 

2.3.4   Edit menu 
Parametei values 

Equations 

gate energy I 

Model name| 

Dfaw model 

Draw sate numbers 

Draw sort numbers 

Parameter values is a cursor mode to change parameter values. 
Equations is a cursor mode to change equations in the parser string. 
Gate energy is a cursor mode to change gate properties. 
Model name is an item to change the name of your active window or 
your selected apparatus. 
Draw model resets your drawing. 
Draw gate numbers sets the gate numbers in the model. 
Draw sort numbers sets the sort numbers in the model 
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2.3.4.1 Edit parameter values (Edit menu) 

Sets the cursor in the Parameter values mode. If you click on an apparatus gate the following dialog 
box is displayed. The last ten parameters are showed. 
As an example the diesel_exhaust apparatus is chosen. 

fjParametei values: diesel exhaust nil 
Index Name Value                       Unit 

0 

1 

1 Actual speed 

INominal speed 

188                           |[rad/s] 

|1000                        |[c/min] 

2 JMin speed limit 

JNominal power 

|C in fuel 

488                           |[c/min] 

3 

4 

|1?88                        |[kW] 

|86                            |[%] 

S |H2 in fuel |13                             |[%] 

6 |S in fuel |i                 |m 
7 JAspect values jjmatrix[4][8]          j|H 

8 ICalculation values |matrix[111[1]             |[] 

up    1                 i 

fl                                  1 
Read file 

Plat mat| 
8- ., §.vf rsn fiancel ■■ ""■'■'      Add Par 

Down              v  . /—' Write file 

Index is the serial number of the parameter in the apparatus. The first parameter starts with number 0. 
The parameter can be a value or a matrix. Every parameter has a name. You can change the name in 
the text box Name. The parameter value must be placed in the text box field Value. This value can be 
a number (for instance: 188) or a global variable (for instance: Ispeed). The unit of the parameter 
must be set in the Unit text box. You can change all values and names. If you click on the OK button 
these values are loaded into the apparatus and the dialog box is closed. If you click on Cancel only 
the dialog box is closed. 

Up and Down button 
With the Up button you can scroll the parameters up, and with the Down button you can scroll the 
parameters down. This is very useful if you have more than ten parameters in the apparatus. 
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Plot mat button 
If there is a matrix parameter you can plot it if you click on the Plot mat button. In the Value text 
box the matrix is expressed with its dimensions (for instance matrix[4][8]). If there are more matrices 
you can select the right one by clicking in the text box Value, and than plot it by clicking on Plot 
mat. The following dialog box is displayed: 

■ Aspect values 
mmMwwmm^mwj^jii^jua mmmmmmm 

"™™"™* 
mmmmm 

dim:m =4 n: =8 ^^^B^H «H 1 n 

I0 

<m)|0 

1 
|729.72 I- 

■ !^^I^^^^M: ■^^pi^& 
|47.4 h 
3.45 h 

1 I^^^H^^a ili5-92 I- 
1 ^^^BWBPHI 1 

8.39153 

1.14105 

0.895361 

1.30457 

fiK I Cancel 

The dialog box displays a part of a matrix. The element index starts with [0][0]. In the upper left text 
box matrix element [m][n] is displayed. 

m and n buttons 
You can scroll through the matrix by changing the values in the text boxes <m> and <n>. To accept 
these values you must click on the m or n button. With the < and > buttons you can click one step 
through the matrix. 

If you click on the OK button the new values are accepted and the matrix box is closed. If you click 
on the Cancel button only the matrix box is closed. 

Read file button 
It is possible to read parameter values from a text file. If you click on the Read file button the 
following dialog box is displayed: 
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File name: 
I 

folder*: 

\ c:\ges\data 
OK 

gasturb.par 
gen.par 
gentab.par 
gesem.par 
ktkq.par 

1 lips, par 
I man4l.par 
I mossel.par 

Cancel 

Network.. 

List f Be« of Jype: 

1 parameter Files ('.par     H 

Driver 
QC: "3 

The default directory is ges\data and the default extension of the file is .par. If you read from a file 
the file must have the correct format. It is possible to read the first parameters into the apparatus. The 
format of the parameter structure is described in the following section (Write file). 

Write file button 
If you click in the parameter dialog box on the Write file button, the following dialog box is 
displayed: 

Save As 

File name: 

I! 
folder*: 

i c:\jjes\data 
OK 

jf gasturb.par 
1 gen.par 
if gentab.par 
| gesem.par 
1 ktkq.par 
I lips, par 
1 man4Lpar 
I mossel.par 

Cancel 

Network.; 

Save file as |ype: '   '   Drives:; 

|parameter Files ('.par    j|       Jo c: 3 
You can type your own file name or choose a file for overwriting. 
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An example of a parameter file is: 

diesel sw28pr 

number of parameters: 8 

0 Variable speed 

1 Normal speed 

2 Min speed limit 

3 Nominale power 

4 % C in fuel 

5 % H2 in fuel 

6 % S in fuel 

7 Aspect values 

766.220000   1.000000 

42.300000 1.000000 

3.090000 1.000000 

2.760000   1.000000 

- on the fist line the name of the apparatus is displayed; 
- on the second line the text number of parameters is displayed: followed by a number; 
- then the parameter fields are displayed. 

The index number is 3 characters in width, the parameter name 30 characters in width, the value 10 
characters width and the unit type 10 characters in width. 
If a parameter is a matrix, the matrix is followed on the next lines. The element value width is 11 
characters. 

Add par button 
If you click on the Add par button you can add a parameter into an apparatus. The following dialog 
box is displayed. 

Add parameters diesel sw28ge 

100 [rad/s] 

1000 [c /min] 

350 [c /min] 

3640 [kW] 

86.9 [- ] 

13 [- ] 

0.1 [- ] 

matrix m:  4 n:  8 [-] 

8 619119 1.348148 0.010719 -0 026816 0 107278 2 000000 

-1 153626 0.651860 12.971739 -23 458330 12 493682 0 000000 

-0 885492 0.261925 5.435819 -14 169077 11 389777 0 000000 

-1 328410 0.577838 24.875213 -59 065051 38 199015 0 000000 

JO Cancel 

It is possible to set the name, value and unit of the new apparatus. If you click on the OK button the 
new parameter is appended and this dialog box is closed. If you click on the Cancel button only the 
dialog box is closed. It is not possible to set a global variable into the Value text box. You can do 
that later in the Value text box of the Parameter values dialog box. 
If you want to add a matrix parameter you must first add a normal parameter. With the Edit 
equations menu you start the parser of GES by clicking on the Equations button. Than you must 
insert the INIT_MATRIX function into the parser string of the apparatus. The parser of GES executes 
this function. 
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2.3.4.2 Edit equations (Edit menu) 

Sets the cursor in the Edit equations mode. If you click on an apparatus gate the following dialog 
box is displayed. As an example a fictive user apparatus (named HullJPropJRot) is chosen. 

Edil apparatus:Hull_Prop_Rot [locked] 

Name lull  Proü  Ro 

Position   0.828645 1-2.53113 3.07923 

View lock Equations 

Ok Cancel Param Copy 

In the first text box you can change the user name. 
There are three text boxes X,Y and Z to define the actual position of the apparatus. You can change a 
position value by fist clicking into the text box. 
If you click on the OK button the changes are set into the apparatus and the dialog box is closed. If 
you click on the Cancel button only the dialog box is closed. 
By clicking on the Param button the parameter list of the apparatus is displayed. This is the same 
dialog box as described in 2.3.4.1 Edit parameter values (Edit menu), page 28. 
A View lock button is shown if the apparatus is locked. This means that this apparatus has 
apparatuses inside and are locked. You can not see them directly by double clicking. By clicking on 
this button a GES window is opened with the apparatuses inside. 
By clicking on the Copy button the apparatus is copied into the model. The following message is 
given: 

Hull_Prop_Rot 

is copied in model 

30; 
The message box is closed by clicking on the OK button. The apparatus is showed on top of the old 
apparatus. It is possible to copy more than one apparatus. 
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If you click on the Equations button the internal parser string of the apparatus is copied into the file 
default.equ and the following dialog is displayed. 

Equations parser Hull Prop Rot 

File name 

default.equ < Change 

Cancel |   Write file!        Edit ! fiK 

If you click on the OK button the equation file in the text box File name is read into the internal 
parser string of the apparatus. The equations dialog box is closed and the parser in GES compiles the 
string. Possible errors are displayed in a message dialog box. If you click on the Cancel button only 
the dialog box is closed. 
You can change the equation file by typing a new name into the File name text box or you can 
choose a file from your own directory. 
If you click on Change a dialog is displayed with some listings to choose an equation file. 
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2.3.4.3 Edit gate energy (Edit menu) 

Sets the cursor in the Edit gate energy mode. If you click on an apparatus gate the following dialog 
box is displayed. As an example the diesel apparatus is chosen. 

Diesel gate nr 0 

gate energy negative     Toggle} Unit 

effort >|M 

flow > jw 

Cancel| |DSE I power 

IIH 

\ 

In the caption of the dialog box the name of the apparatus and the chosen gate number are displayed. 
The sign of the energy flow (gate energy negative) is displayed in the box. With the Toggle button 
you can change the sign of the energy flow. If the gate is connected to another apparatus the toggle 
does not work. Be careful with changing the energy flows of the gates because not all gate equations 
of the apparatuses take into account the sign of the energy flow. 
In the effort text box you can change the name of the effort. The default effort text is for most 
apparatuses an e. Next to the effort text box is the Unit text box to change the unit of the effort. In 
the flow text box you can change the name of the flow. The default flow text is for most apparatuses 
an f. Next to the flow text box is the Unit text box to change the unit of the flow. In the power text 
box you can change the power unit of the gate. 
If you click on OK the values are set into the apparatus and the dialog box is closed. If you clink on 
the Cancel button only the dialog box is closed. 
You can open more Edit gate energy dialog boxes by clicking on another gate. The next dialog box 
is displayed on top of the other. You can drag them apart. 

2.3.4.4 Draw model (Edit menu) 

If you click into this menu you can redraw the model. 
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2.3.4.5 Draw gate numbers (Edit menu) 

If you click into this menu the gate numbers of the apparatuses are written in the model. See the 
following example. 

1 
11  ^ I Trans 
>rHull_Prop_Rot 

Generator 
Coil 

The gate numbers disappear by redrawing the model. 

2.3.4.6 Draw sort numbers (Edit menu) 

If you click into this menu the sort numbers of the effort and flow functions are written in the model. 
See the following example. 

I 

vU-~11 Xi 

Resis. 

i    J    s- 

17 

19 
18  e\er 
,J Jui?ct. 

Hydrau 

IOV^^S 
Diesel 

Fuel 

Trans. 
Hull_Prop_Rot 

<£ .3 
Coil 

r2' 
8 

Generator 

The sort numbers disappear by redrawing the model. 

Remark: Sort numbers are internal rank values of the effort and flow functions. These sort numbers 
are generated by GES if you perform a simulation, else all sort numbers are zero. 
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2.3.5   Options menu 

Connect 

ßuconnect 

Copy 

Mantle 

fismanlle 

UriMask 

Lock 

Unlock 

De'ete 

Delete AS 

Connect is a cursor mode to connect apparatuses. 
Disconnect is a cursor mode to disconnect apparatuses. 
Copy copies a selected apparatus. 
Mantle is a cursor mode to mantle apparatuses. 
Dismantle is a cursor mode to dismantle apparatuses. 
Mask prevents a mantled apparatus for calculation. 
UnMask unmasks a mask apparatus. 
Lock locks a mantled apparatus. 
Unlock unlocks a locked apparatus. 
Delete deletes a selected apparatus. 
Delete All deletes the model. 

2.3.5.1 Connect (Options menu) 

This option sets the cursor in the Connect mode. In this mode you can connect apparatuses together. 
A necessary condition for connecting apparatuses is that the gate flows must be different as well as 
the gate variables (effort and flow). 
If you choose an open gate a line is drawn between the gate and the cursor. If you click on the gate of 
the connecting apparatus GES checks the connection conditions. If the connections are successful a 
connection is made. 
In a special case you can connect an apparatus gate to an already connected apparatus pair. In this 
situation GES calculates some conditions and shows a message to generate an 1- or 0-junction. The 
user must estimate whether the new generated junction between the apparatuses is practically useful. 
See the following example: 

Hydrau 
j- *• - • M 

'".£-''' 1    -'"«" 

generator 

In this example we will connect the generator to the Diesel shaft. The Diesel engine delivers the 
speed (is a flow) of the system and is connected to a hydraulic system. You can see that the Diesel 
engine may also be connected to the generator (same energy and variable conditions). If the cursor is 
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set into the Connect mode and we want to connect the generator to the Diesel shaft, GES gives the 
message "generate 1-junction" as follows: 

generate 1 Junction 

||       Cancel    j rTtiC 

Trans. 

Hydrau 

generator 

GES has established that a 1-junction generation between the apparatuses is possible. The property of 
a 1-junction is that for every gate the flow is equal (in this situation this is the shaft speed). 

In the following example you can make a connection, but the connection is not practically correct. 
The model contains two Diesel engines. These engines both deliver a flow variable. We want to 
connect the shafts. A 0-junction is not correct because for a 0-junction the effort (torque) of all the 
gates is the same. 
To solve the problem one Diesel must calculate a torque variable or you must place a /„distributor 
apparatus between the Diesel engines. 

Graphical interface, GES menus 



TNO-report 
96-CMC-R0274 

GES User's Guide version 1.05 Date Page 
December 15, 1997 38 

2.3.5.2 Connect gate to mantle apparatus (Connect mode) 

If your mantle apparatus has free gates you can connect a free apparatus to the mantle by dragging 
the mouse to the edge of the window. If you click in the edge area a list of free gates of the mantle 
apparatus is displayed. See for instance the following example: 

IN Eite  L^rary  §dit   Options   Simulation  Iool»   Style  Vtfndow   Help 

The mantle apparatus is the Hull_Prop_Rot apparatus from the benchmark. This mantle apparatus 
has two free gates, numbers 0 and 1. In this example the free gate of the hull apparatus is chosen. 
By default GES takes the last number 1, but you can also choose another by typing 0. 

2.3.5.3 Disconnect (Options menu) 

This option sets the cursor in the Disconnect mode. In this mode you can disconnect apparatuses by 
clicking on a connected gate. If the apparatuses are disconnected they are drawn with there default 
gate vector values. It is possible that a default gate vector lies on the old connection line. In that case 
you cannot always see whether the disconnection is correct. In case of doubt you can drag an 
apparatus. 

2.3.5.4 Copy (Options menu) 

If this item is active you can copied the selected apparatus. See also 2.3.4.2 Edit equations (Edit 
menu), page 32. 
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2.3.5.5 Mantle (Options menu) 

With this option you set the cursor in the mantle mode. In this mode you can put apparatuses in one 
apparatus (the mantle apparatus). If you set the cursor in this mode and you select an apparatus, than 
this apparatus is first mantled. This mantle apparatus has the same number of gates as the selected 
apparatus. The selected apparatus is in the mantle apparatus and is connected inside. The name of the 
mantle apparatus starts with m_ and is appended with the name of the first selected apparatus. 
If you do not leave the Mantle mode all following selected apparatuses are put into the mantle 
apparatus. If the selected apparatus has connections with other apparatuses the number of gates of the 
mantle apparatus is adjusted. The minimum number of gates is always one because otherwise you 
could not select the apparatus. 
The mantle apparatus is drawn with a dotted line. 

2.3.5.6 Dismantle (Options menu) 

With this option you can set the cursor in the Dismantle mode. In this mode you can remove the 
mantle apparatuses in your model by selecting them. The mantle apparatus is recognized as an 
apparatus that is drawn with a dash-and-dot line. If a mantle apparatus is dismantled the apparatuses 
inside are show in the window. 

2.3.5.7 Mask (Options menu) 

With this option you can mask a selected mantle apparatus. You mask an apparatus for preventing it 
to be calculated. If you want to mask a not-mantled apparatus you must first mantle the apparatus. 
A masked apparatus is drawn with a thick blue line. If the selected apparatus is correct the following 
window is opened. 

y Trans. 

Hull Pnl 
Hull_Prop_Rot 

m \ Mask apparatus 

¥«    a       No 

Remark: 
With a run apparatus you can simulate mask apparatuses individually. 
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2.3.5.8 UnMask (Options menu) 

With this option you can unmask a masked apparatus. A masked apparatus is drawn with a thick blue 
line. If the selected masked apparatus is correctly chosen the following window is opened. 

J33^ 
Hull_Prop_Rot 

Hull_Prop_Rot 

P \* M    UnMask apparatus j 

' "'."" No ; Yes 

2.3.5.9 Lock (Options menu) 

With this option you can prevent to go in a mantled apparatus. A locked apparatus is drawn normally. 
If you select a locked apparatus in the edit equations mode you can look in this apparatus. In a further 
version of GES we want to give the locked apparatus its own global workspace. 

2.3.5.10 UnLock (Options menu) 

Unlocks a locked apparatus. 

2.3.5.11 Delete (Options menu) 

With this option you can delete a selected apparatus. If the selected apparatus is correct the following 
window is opened. 

C 
Hull_Prop_Rot 

Hull_Pmp_Rot 

3> Delete apparatus ? 

Yes No 

Remark: 
You can also delete an apparatus by pressing on the Del key after the apparatus is selected. 

Graphical interface, GES menus 



TNO-report GES User's Guide version 1.05 Date Page 
96-CMC-R0274 December 15,1997 41 

2.3.5.12 Delete All (Options menu) 

With this option you can delete the complete model. This option is only active in the first model 
window, else the menu bar is grayed. If you delete the model all objects are removed from memory, 
except the system workspace. 
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Parameter setup 

2.3.6   Simulation menu 

The Simulation menu consist of eight sub-parts: 
<   Start starts a simulation dialog box. The name is Stop when the 

program is running. 
1   Parameter setup is used for changing the parameters in steps. 
1   Results mode is a cursor mode to display the results. 
1   Set Plot window sets a screen to plot results data in 2D. 
'   Simulation parameters displays a dialog box with iteration values. 
1   Animation makes an animation of a selected apparatus. 
1  Benchmark inserts a propulsion installation in an empty window. 

•   Sum parameters calculates the sum of parameters with the same 
name. 

2.3.6.1 Start (Simulation menu) 

Set FJot widow 

Simulation parameters 

Anfffratbn 

genchmark 

Sumjwirameieis 

1 Start Simulation app:Propulsion installation SEI Ell 

Qutputflle: bufges.dat 

Clear 

^^^^^^^^^^^^^^^B £ort_C_Func| 

SortJJFuncI 

 -■■—:-•■  ••-:•- ■■■-■■ :U__;_. 

Cal        1 1^^^^^^^^^^^^^^»p^B 
Bun £G       £ancel|  1 

- :. r   _  

With this menu you can calculate your model at three methods. 

• Manually by clicking on Clear, Sort_C_Func, Sort_I_Func and then by clicking on Cal. 
• Clear sets all gates at zero. These are the starting values of the iteration process. 
• Sort_C_Func sorts all explicit functions. 
• Sort_I_Func sorts all implicit functions and the remaining explicit functions. 
• Cal starts the simulation of the sorted functions. 

• In the foreground by clicking on the Run button. The simulation starts in the foreground with a 
specified number of steps. 
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•   By clicking on the BG button. The simulation starts in the background continuously. 

The status of the calculation is displayed in the list box. 

2.3.6.2 Parameter setup (Simulation menu) 

I Parameter setup E3| 
apparatus 

< Del | 

[ m 

Add   1 

parameter 

Diesel 1 jj   Not used1 1 

Diesel 

[   index r"^^^^ 
1 

min 

value 

||riot used 

max 

Steps 

!° 
r sue i Add free [ 

  

In this menu you can change the parameters of an apparatus in a few steps. In the apparatus list box 
the apparatuses are listed for changing a parameter. You select a parameter of an apparatus in the 
parameter list drop box. If the selected parameter is a matrix you must set the element indexes in the 
m and n fields. The actual parameter value is given in the value field. In the min and max fields you 
must set the minimum and maximum required value of the parameter. 
By clicking on the Del button you can remove an apparatus from the apparatus list and with the Not 
used button you can skip a parameter for changing. 

Steps button 
You can set the number of steps with the Steps button. The following dialog box is displayed. 

Proces steps 

Input Proces 

in—: 
OK Canedi 
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The default number of steps is one. For varying a parameter from the minimum until the maximum 
value a step size of 100 is recommended. 

Add button 
You can insert an apparatus in the apparatus list by clicking on the Add button. The Parameter 
setup dialog box is closed. The cursor is set in the parameter setup mode. If you select an apparatus 
in your model the Parameter setup box is displayed with the new added apparatus in the list. You 
can add more apparatuses and setup the minimum and maximum values. 

Add free button 
With this option it is possible to change the input variables (effort or flow) of the free gates of an 
apparatus in steps. 
If you click the Add free button, all apparatuses with free gates are inserted in the apparatus list. For 
every free gate the apparatus is inserted. If you select an apparatus in the apparatus list the free gate 
number is displayed in the value field as gate : * . The user can set the minimum and maximum value 
to change the gate by steps. 

Graphical interface, GES menus 



TNO-report 
96-CMC-R0274 

GES User's Guide version 1.05 Date Page 
December 15, 1997 45 

2.3.6.3 Results mode (Simulation menu) 

With this option you set the cursor in the Results mode. If you click on a gate of an apparatus a 
dialog box is displayed with all calculation results of the selected apparatus. 

Analyse app: Diesel □as 
Dissipation: 
Efficiency: 

653979 |W) 
0.392136 H 

gate effort flow power|W] 
0   2244 188 4.219e*05 
1   4.27e+Q4 25,2 1,076e*06 

ok gate numbers      workspace     parameters 

For the complete apparatus the dissipation and efficiency are calculated. The efficiency is zero for an 
apparatus with one gate. For every gate the effort and flow variable is listed. The power of every gate 
is calculated. 
If you click on the gate numbers button the gate numbers are drawn into the model. See also 2.3.4.5 
Draw gate numbers (Edit menu), page 35. If you click on the OK button the dialog box is closed. 
By clicking on workspace the local- and global workspace is displayed. If the system variable 
view_syswrkspc=l in the initialization file GES.INI is set to 1 the system workspace is also 
displayed. 
By clicking on parameters the parameter list of the apparatus is displayed. See also 2.3.4.1 Edit 
parameter values (Edit menu), page 28. 
If you select another apparatus a new results dialog box is displayed over the old one. You can move 
the results dialog boxes to compare the results. 

2.3.6.4 Set Plot window (Simulation menu) 

This menu sets a plot window for plotting your results. See 2.4 Plot window, page 54. 
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2.3.6.5 Simulation parameters (Simulation menu) 

The default values for the iteration process are given in the following dialog box. 

1 Iteration values 
"^gffla'ffi'lSiaiMiMM'JJW"^»''.".'!'!!!!! I 

m 

7m 

flow iteration 
effort iteration 
Generate causal element 

Maxits    ] iTTI 

Toll 1 .Oe-6                  < 
Tolmin    1 1.0e-6                  < 
Tolx I.Oe-7                  F 

Stpmx "1 100.0 
-   ■■ — - ■ ■   : •■-'■• 

1.0 IO_offset: 1 Xy<3|    fiancel |   gefault] 

• Maxits is the maximum number of iterations. 
• Tolf sets the convergence criterion of function values. 
• Tolmin sets the criterion for deciding whether spurious convergence to a minimum of a function 

has occurred. The function value is checked until Tolmin a real minimum has occurred. If the new 
step is too close to the old step size this check is made if the convergence is spurious. 

• Tolx is the convergence criterion on the step size. 
• Stpmx is the scaled maximum step length allowed in line searches. 
• IO_offset is the offset value of the starting values of the iteration process. 

Effort or flow iteration 
With the radio buttons you can choose whether GES first searches for a flow or an effort function at 
the iteration equations. 
For instance if the equations for iteration are el=gl(ß) and f2=g2(el,constant). The function in the 
flow iteration mode is:ß=g2(gl(ß),constant). el in this mode is calculated directly. 
In the effort iteration mode the iteration function is: el=gl{g2(el,constant)). In this mode el is 
solved by iteration and/2 is calculated directly. 

Generate causal element 
With this option on, GES generates automatically a causal element if two apparatuses with the same 
variable type (effort, effort or flow, flow) are connected. 
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By clicking on Default you can make the chosen iteration values default followed by clicking on OK 
in the following dialog box. 

Set Default 

DQ JIOU wait to change the default vaiues 
T hi« change will affect a8 new GES models 

OK Pj       Cancel 

The default values are set in the GES.INI file. 

2.3.6.6 Animation (Simulation menu) 

With the animation option you can move the selected apparatus. The orientations of the apparatus are 
read from a binary file. If you choose this menu a dialog box is displayed with the directory name. 

Animation file 

\ C:\ges2Kl\data 

OK Cancel 

The binary animation file must contain the position and the rotation information. The information is 
sequentially read. Each time the apparatus drawing is cleared and redrawn with the new orientations 
until the end of the file is reached. 
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2.3.6.7 Benchmark (Simulation menu) 

If the model is empty this menu gives a benchmark of a propulsion installation of a ship. You can use 
this model for learning how GES works and for making a start for a new propulsion installation. 

Resis. 

L —- ^ Trans. 
Hull_Prop_Rot 

f^\U--^ Junct. 
Hydrau 

Diesel 

Generator 
Coil 

Figure 3   Benchmark of a propulsion installation 

Remark: 
Not all apparatuses in the benchmark are derived from the import library, because they where 
constructed in the design phase. It is possible to change an apparatus with the equivalent import 
library apparatus. The results must be the same. For a GES starter this is a nice lesson. 

2.3.6.8 Sum parameters (Simulation menu) 

With this option is it possible to calculate the sum of the parameters with the same first name in the 
model. If you choose this menu the following dialog box is displayed. 

Sum parameters Propulsion installation 

Name Value Unit 

Cal Cancel 

In the field Name you must set the parameter name. If you click on the Cal button, GES adds all 
parameter values with the 'same first name' together. This is done from the window where the 
calculation is started. The result is set in the Value field. 
By comparing the parameters the names are not case sensitive. The first blanks are skipped and all 
characters after the first word are not taken into account. 
For instance if the parameter word is mass. GES adds the values of the parameter names: mass 
engine, mass propeller and mass gearbox, but not transmission mass. 
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2.3.7 Tools menu 

The user can ran four tool programs with GES. The default programs are Mossel, Quaestor and 
Notepad. It is possible to run other programs by editing the entry tool(l, 2, 3, 4) in the GES.INI file. 
The names in the menu are default. The programs or links must placed in the root directory of GES. 

Quaestor 

Motsel 

Notepad 

Mossel starts the batch file Mossel.bat for calculation of aspect values. 
Quaestor starts the batch file Quaestor.bat. 
Empty place. 
Notepad starts Notepad.exe 

2.3.7.1 Quaestor (Tools menu) 

The tool program Quaestor is started by the .bat file Quaestor.bat 

The file Quaestor.bat contains: 

cd  \ 
cd c:\q\programs 
qst.exe 

qst.exe is the Quaestor program. 

2.3.7.2 Mossel (Tools menu) 

The tool program Mossel is started by the .bat file mossel.bat. The batch file must be in a directory 
given by the system path name. The program Mossel calculates coefficients to characterize a gas 
turbine or a diesel engine. The program GES uses these coefficients. 

The file mosselbat contains: 

cd \ 
cd c:\mossel 
mossel.exe 
mos_ges.exe gesem.dat c:\ges\data\mossel.par 

mossel.exe is the Mossel program. 

If you stop the program Mossel, Mossel writes its results to the file c:\mossehgesem.dat. 
This file is not in GES format. The program mos_ges.exe translates the file c:\mossehgesem.dat to the 
file c:\ges\data\mosselpar. You can read this file in the parameter fields of the apparatus 
diesel_exhaust. See for the description of this apparatus 3.3.2 Diesel exhaust, page 99. 
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• Rotate X axis Rotates a selected apparatus about the X-as. 
• Rotate Y axis Rotates a selected apparatus about the Y-as. 
• Rotate Z axis Rotates a selected apparatus about the Z-as. 
• Change Drawing changes the drawing of a selected apparatus 

2.3.8.1 Rotate X axis (Style menu) 

Rotates a selected apparatus about the X-as. 

2.3.8.2 Rotate Y axis (Style menu) 

Rotates a selected apparatus about the Y-as. 

2.3.8.3 Rotate Z axis (Style menu) 

Rotates a selected apparatus about the Z-as. 
First you must select an apparatus. The selected apparatus is written with a dotted line. 
By clicking on this menu the selected apparatus is rotated on the global z-axis. The rotate menu 
rotates the selected apparatus by 90 degrees respectively. 
Examples of the apparatus orientations: 

0 degrees 90 degrees 180 degrees 

IN, 

270 degrees 

Figure 4  Apparatus rotations in the z-direction 

2.3.8.4 Change drawing (Style menu) 

You can change a drawing by first selecting an apparatus. The selected apparatus is written with a 
dotted line. Change drawing in the Style menu displays a dialog box with the name of the selected 
apparatus. 
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Change drawing Diesel 

File name 

default.drw < Change 

fiancel!   Write file) V-   „^ Fuel 
Diesel 

Generator 
Coil 

By clicking on the OK button the drawing is read from file (default file is default.drw) and loaded 
into the apparatus. You can change the file with the Change button. If you click on the button Write 
file, the drawing of the selected apparatus is written to the file given by the File name field. If you 
click on Edit the notepad editor (for Windows) is started and gives the code of the drawing in text 
format. The format of the drawing is: 

Text format of the drawing. Format code between the brackets [    ] is optional. 

(Number of points) (number of columns) [x scale] [y scale] [z scale] [comment] 
x-position y-position z-position line-output #  [line color]   [comment] 

[(number of gates) 
(gate number)    x-position y-position z-position 
(gate number)    x-position y-position z-position 

(gate number)    x-position y-position z-position 
(gate number)    x-position y-position z-position 

//start of energy vector 
//end of energy vector 
//empty line 

Table 2  Drawing format 

The number of points is usually the number of x-y-z-values. This number may be less than the real 
numbers given in the file. The number of columns must be 4 for figures without a line color (default 
color is black). If you want to give the line-output functions an individual color, the number of 
columns must be 5. 
The x y and z scale factors are optional and are used to size the incoming line-output functions. The 
default value is 1. The comment is optional and can be 64 characters in length. 
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The x-y-z-positions are floating point values of at least 10 characters in length. The x-y-z-positions 
must be given in local coordinates. 
There are 4 line-output functions: 

line-output functions line-output # number of x-y-z-positions Description 
line 1 2 draws a line 
poly line 2 ending with-2 a set draws a set of line segments 
triangle 3 3 draws a triangle 
square 4 4 draws a square 

Table 3  Line-output functions 

You can build your figure by mixing the line-output functions. 

There are 6 line colors: 

color [line color] 
black 0 
blue 1 
green 2 
cyan 3 
red 4 
magenta 5 

Table 4  Line colors 

Number of gates is the number of gate vectors you want to change. This feature is optional. You can 
change the position of the gate energy vector, by giving the positions of the start and the end vector. 
The positions are given by a gate number and the x-y-z-positions. The scale-factors [x][y][z] have 
no effect on these values. Every position must be written on a new line. Between the gate vectors an 
empty line (CR) must be inserted. 
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Example: Block model of the apparatus diesel (only one poly line) 
10  4 Diesel 
-0.500000 -0 500000 0 000000 2 .000000 poly line 
0.500000 -0 500000 0 000000 0 000000 
0.500000 -0 500000 1 000000 0 000000 

-0.500000 -0 500000 1 000000 0 000000 
-0.500000 -0 500000 0 000000 0 000000 
-0.500000 0 500000 0 000000 0 000000 
0.500000 0 500000 0 000000 0 000000 
0.500000 0 500000 1 000000 0 000000 

-0.500000 0 500000 1 000000 0 000000 
-0.500000 0 500000 0 000000 -2 000000 end poly 

2 nr gates 
0  -0.500000 0.000000 0.500000 
0  -1.500000 0.000000 0.500000 

1   0.500000 0.000000 0.500000 
1   1.500000 0.000000 0.500000 

2.3.9   Help menu 

See 2.2 GES MDI window, page 17. 
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2.4 Plot window 

In a plot window you can plot your results as a linear graph of 2D data. You can also make a set of 
data. If you choose this menu a window for plotting your data is opened. You can open more than one 
Plot window. 

[Fuel dm/dt] 

Plotlayout   Plotmode   Result   Help 
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If you click on one of the gates of an apparatus and there is data available this data is plot in the plot 
screen. The default data variable is the flow of the gate. The default X axis is the number of steps. 
The Y axis is automatically scaled (XY AUTOPLOT). In the Result menu you can change this mode. 
If there are more Plot windows than one, you can select the screen by first clicking in the plot screen 
area with the mouse cursor. 

2.4.1 Plot layout 

£et world 
floUtjde 

Hike V data X axk 
ü^eX«fl»«leps 

MakeXaHStime 

Print displays a print dialog box to print the plot. 
Set world displays a dialog box, with world coordinates. 
Plot style displays a dialog box, with plot sizes. 
Make Y data X axis changes the X axis with the actual Y axis. 
Make X axis steps changes the X axis with step numbers 

In the plot layout menu, you can print a plot, set the axis world for fixed axes plotting, set the plot 
style and change the X axis data. 

Graphical interface, Plot window 
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Clicking on Print displays a print dialog box to print the plot. 

Clicking on Set world displays the following dialog box, with default values: 

plot world HE) 
min max 

i 

Xaxis |° 1 

Yaxfs 1" 1 

OK 
t    •■*■" 

Cancel! gefault 

You can set in the min and max axis fields the minimum and maximum value of the X axis and the Y 
axis. These values are used if you plot data with fixed axes (XY DATAPLOT). If you click on the 
OK button the values are accepted. If you click on the Default button the default values are set. 
Clicking the Plot style menu displays the following dialog box to change axis' size and positions. 

plot style m 
t 

t 

X axis Yaxis 

axis orig, jo.15 1 0.2 

axis size 0.7 0.7 

axis point0.15 0.2 

divisions I5 10 

axis on    Fon/o« IBI 7 on/off 

color       h 4096 print size 

grid on    [7 on/off 

label on   r< on/off 
Ü 7 on/off 

7 on/off 

header    jo.5 0.5 

li OK! £ancel          ßefaultj 

  

The values in the dialog box are the default values. 
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The axes' origins are expressed in the following figure: 

1,1 

/? 

1 
N/    Axis point and data origin 

< 

/ 
-x 

> 
Axis origin 

0,0 

Figure 5  Diagram plot axes 

The axes are described in logical values. 
axis orig. specifies the origin of the axis area as a fraction of the overall area. Values can range from 
Otol. 
axis size specifies the size of the axis area as a fraction of the overall window area. The values can 
range from 0 to 1. 
axis point is a position within the window where the X and Y axes intersect. 
divisions specifies the number of thick marks for the axes. 

In the print size field you can resize your print. This value is also used for printing the model. See 
also 2.3.1.7 Print (File menu), page 25. 
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3 Import library 
The GES library consists of eight sub-libraries: 

• General is a sub-library for general apparatuses. 
• Electric is a sub-library for electric apparatuses. 
• Mechanical is a sub-library for mechanical apparatuses. 
• Hydraulic is a sub-library for hydraulic apparatuses. 
• Thermodyn. is a sub-library for thermodynamic apparatuses. 
• Maritime is a sub-library for maritime apparatuses. 
• Elements is a sub-library for element apparatuses. 
• Components is a sub-library for ideal apparatuses. 

I      bieneral ■4& 

Electric ^ 
Mechanical ► 
Hjidraiiic ► 

Thermodyn. ► 
Maritime ► 
Elements ► 

Component* ►I 
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User defined 

Quaestor interface 

Earamater change 

Workspace 

]ni sate 

£alwe module 

fiun apparatus 

3.1 General library 

The general library consist of seven apparatuses and or groups: 
• User defined displays a dialog box to set up a user defined 

apparatus. 
• Quaestor interface is an entry to select interface apparatuses. 
• Parameter change is an entry to select apparatuses to change 

parameters. 
• Workspace is an entry to select apparatuses with the global 

workspace. 
• Init gate sets a gate variable in the model. Used for iteration 

processes. 
• Failure module displays a dialog box to create a switch apparatus. 
• Run apparatus starts a simulation of an apparatus. 

3.1.1 User defined 

See 5.6 Program, page 178. 

3.1.2 Quaestor interface (signal type) 

With this menu two types of apparatuses can be created: the epi apparatus and the epo apparatus. 
The epi apparatus reads data from file and the epo apparatus writes data to file. The input and output 
file must have the same structure (the "Telitab" format). The structure is: 

"number" total number of values between semicolons. Fe. 
"3". there are following now 3 groups 

*< i •» value first number between semicolons (field 10 
characters) and a floating point value 

"2" value second number between semicolons (field 10 
characters) and a floating point value 

• et cetera 

"number" value last number between semicolons (field 10 
characters) and a floating point value. 

Table 5   "Telitab" format 

It is possible to use both apparatuses for an interface with other programs. 
The program Quaestor uses batch programs with this file structure for communication with the 
outside world. To synchronize the communication between the batch program and the GES program a 
flag file is used as a semaphore. The communication is as follows. The batch program must make the 
flag file and the epi apparatus must wait for the flag file. Then the batch program must wait until the 
flag file is removed. If GES is ready witch the calculations GES must create an epo file and remove 
the flag file. This happens only if there is an epo apparatus in the system. The epo apparatus writes 
only one value to the epo file. For every written value to the epo file an epo apparatus must be used. 
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With the Quaestor interface dialog box you can choose an epi apparatus or an epo apparatus. 

Quaestof interface 

<M epi 

epo! 

OK   |     Cancel] 

You resume by clicking on the OK button. 
The name of the chosen apparatus is given in the capture of the following dialog box. The name is the 
default name of the apparatus type. You can change the name of the apparatus in the text box name. 

1 Create apparatusiepi BEE 
name 

X 

Hepi 

I^^^B z 

1» ^0 1° 

ncel 1 Param i Create \ Ca 

If you click on Create the apparatus is set in memory. If in memory you can edit the parameter list of 
the apparatus by clicking the Param button. 
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3.1.2.1 epi apparatus (signal type) 

:.-Pn_ 

epi 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no P [-] flow [-] 

Table 6   Gate variables epi apparatus 

The epi apparatus reads just one value from a text file in epi format from one particular place. This 
value is set in the parameter list of the connected apparatus. The position in the epi file and the 
position of the parameter in the connected apparatus must be specified in the parameter list of the epi 
apparatus. 

| Parameter values: epi m 
Index Name Value                        Unit 

0 (parameter .epi 

>  

|[- 

1 pi |[- 

2 jconnected parameter I»               li- 
3 I   dim parameter m I»               li- 
4 I   dim parameter n: I»                H- 
5 Iwait for flag I' |[- 

I                 I 
i| 

, I  
Un      I          :....:. Read file 

Plot mat Add Par | f fiK Cancel 
Down Write file 

.'•**> 
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Parameter(0): 
Contains the position in the epi file for reading the value. If the value is 0, then no value is 
read. 

Parameter(l): 
The path and name of the epi file must be placed in the field Name. Path and filename 
maximum 30 characters. 

Parameter(2): 
Is the index number of the parameter of the connected apparatus. If the parameter of the 
connected apparatus is a matrix the position in this matrix must be given by parameter(3) and 
parameter(4). 

Parameter(3): 
This value is the row number of the matrix of the parameter of the connected apparatus. The 
value is only used if the parameter is a matrix. 

Parameter(4): 
This value is the column number of the matrix of the parameter of the connected apparatus. 

Parameter(5): 
If wait for flag is 0 the epi apparatus reads the value from the epi file. 
If wait for flag is 1 the epi apparatus reads only the value from the epi file if there is a 
special file, called the flag file. The name of the flag file is derived from the epi file name. 
See for the file name parameter(l). The extension of the flag file is .flg. 

Example: In this example an epi apparatus is connected to a diesel apparatus. GES executes first the 
epi apparatus. The epi apparatus reads one value from an epi file and places this value in the 
parameter list of the diesel apparatus. This could for instance be the speed of the diesel engine. 
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3.1.2.2 epo apparatus (signal type) 

epo 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no e C-] flow f [-] 

Table 7   Gate variables epo apparatus 

The epo apparatus writes result values of one gate to an epo file in a particular place. The values are 
of the connected apparatus. These values can be the effort, flow and power of one gate of the 
connected apparatus and the dissipation and the efficiency of the apparatus as a whole. The epo 
apparatus first writes the chosen values in an internal buffer (not visible for the user). After 
calculation GES writes the values from the buffer to the epo file. You can use more than one epo 
apparatus. All these epo apparatuses write in the same buffer, but only one epo file is created. If a 
position in the epo file is not mentioned in the parameter list of one of the epo apparatuses a value of 
-999999 is placed at that position. The name of the epo file is obtained from the last running epo 
apparatus. It is recommended to use the same epo file name in all epo apparatuses. The maximum 
position number in the parameter list of one of the epo apparatuses is its total number of values in the 
epo file. 

Example: an epo file if only one flow value of 1.880000e+02 is written in position 3. 

3 
II -I   II 

II O II 

"3" 

-9.999990e+05 
-9.999990e+05 
1.880000e+02 

If there is a flag file created by another program the flag file is removed. 
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Parameter values: epo Bl 
Index Name Value Unit 

0        jeffort     > parameter .epo 1» ■          1 
1        Iflow       > parameter .epo 1» i 
2        1 power      > parameter .epo |n I. 
3        |dissipation> parameter .epo 1° i 
4        lufficiency > parameter .epo ij° i 
^                               po jo l^ile]                   | 

G        Igate number apparatus out jo 1             !3| 

i 

Plot mat 1 
1 

UU         1                                              Menrt til» 

Cancel 1 
1    ]           # »www   t»iw 

OK 
Down 

Add Par         
""          Write Tile 

Parameter(O): 
The effort value of the gate of the connected apparatus. Value is the place in the epo file. If 
this value is 0 no effort value is placed in the epo file. 

Parameter(l): 
The flow value of the gate of the connected apparatus. Value is the place in the epo file. If 
this value is 0 no flow value is placed in the epo file. 

Parameter(2): 
The power value of the gate of the connected apparatus. Value is the place in the epo file. If 
this value is 0 no power value is placed in the epo file. 

Parameter(3): 
The dissipation value of the connected apparatus. Value is the place in the epo file. If this 
value is 0 no dissipation value is placed in the epo file. 

Parameter(4): 
The efficiency value of the connected apparatus. Value is the place in the epo file. If this 
value is 0 no efficiency value is placed in the epo file. 

Parameter(5): 
The name of the epo file must be placed in the text box Name. Path and filename maximum 
30 characters. 

Parameter(6): 
In Value the appropriate gate number of the connected apparatus must be inserted. This 
number is the gate number of the connected apparatus. 
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Example: In this example an epo apparatus is connected to a diesel apparatus. GES executes first all 
the normal apparatuses. After calculation the epo apparatus writes a few selected values (selection: 
effort, flow, power, dissipation, efficiency) of one of the diesel engine gates (0 or 1) to an internal 
buffer. This is first done for all epo apparatuses. Then GES creates one epo file with all these results. 
A possible flag file is removed. 

epo 

3.1.2.3 Quaestor interface example 

Quaestor is a DOS program which calls the batch program interface. The batch program is a stand- 
alone program that communicates with the outside world through a set of files. The communication 
files between the interface and Quaestor have the extension .epi for standard input files and .epo for 
standard output files. They both have the TELITAB format. The interface program can read the epi 
file and must create the epo file. For communication with GES the interface program must create 
another epi file, for example we choose the extension .gin. After that a flag file for synchronization 
needs to be created by the interface program. The interface program shall wait until the flag file is 
removed. If GES is ready with the calculation it creates an epo file with extension .gou and it removes 
the flag file. Next the interface program reads the .gou file and creates an epo file. If the interface 
program is ready, Quaestor can read the epo file. 
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INTERFACE 

Figure 6  Interface configuration 

GI GOU 
A 

iL 

GES 
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V 
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Library with 
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apparatus 

~7K 

CONFIGURATION 
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Example: 
An example of a GES model with one epi and two epo apparatuses is given in Figure 7. 

epo2 

r\1 
M 

Diesel 

^fTXU-^ Hydrau 
Trans. 

ull_Prop_Rot 

f 

Fuel 

Generator 
Resis. Coil 

Figure 7  Interface model with epi and epo apparatus 

For continues communication with other programs GES must calculate in the background mode for a 
few steps the user can use the foreground mode. 
The epi apparatus reads the speed of the diesel engine from an epi file intface.gin. For 
synchronization the parameter(5) wait for flag must be 1. The speed value is placed in parameter(O) 
of the diesel engine. If the flag file \q\interface.flg exists GES resumes the calculation. The last 
apparatuses in the calculation list are the two epo apparatuses. For instance the epol apparatus 
writes the velocity of the ship to the epo file \q\interface.gou and the epo2 apparatus writes the fuel 
mass flow to the epo file. Than GES removes the flag file and the interface program can read the epo 
file. 
This example model can run without the Quaestor interface program, if the wait for flag option in the 
epi apparatus is set to zero. 
See for this model ges\examples\epi_epo.mod. 
The example epi file example.gin is also in ges\examples. Position two in the epi file gives the speed 
of the diesel engine. 
The epol apparatus sets the speed of the ship at position two in the ges\examples\gesintf.epo file. 
The epol apparatus sets the fuel consumption on position three in gesintf.epo. 
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3.1.3 Parameter change 

If a total energy system model is built it is possible to set some particularly gate values in the system 
by changing a few parameter values of the apparatuses automatically. 
To change parameters in the system we need at least two types of apparatuses: the set apparatus and 
the par apparatus. The set apparatus is used as set point in the system and the par apparatus is used 
as apparatus for the parameter changes. There must always be a pair. GES gives a warning if there is 
not a pair. You can find this warning for background calculation in the log file. 
GES solves the system of more than one pair of set-par apparatuses with a Newton-Rapson method 
for non-linear systems. This is the same method for solving the energy system equations of GES. The 
iteration limits can be changed in 2.3.6.5 Simulation parameters (Simulation menu), page 46. 

With the Parameter change dialog box you can choose a set apparatus or par apparatus. 

Parameter change 

<* setjpolnt 

C para_variable 

?WC Cancel 

You resume by click on the OK button. 
The name of the chosen apparatus is given in the capture of the following dialog box. The default 
name is set for a set apparatus and par for a par apparatus. You can change the name of the 
apparatus in the text box name before the apparatus is created. 

Create apparatus: set 

name: Iset 

Create Cancel Param 
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3.1.3.1 set apparatus (signal type) 

-■-&-> 

»-' 
set 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no P [-] flow [-] 

Table 8  Gate variable set apparatus 

The set apparatus is used as a set-point in the system. The par apparatus changes a parameter in the 
system until the set-point value is reached. You must always use a set apparatus with a. par apparatus 
as a pair. GES solves the system for more than one pair of set-par apparatuses. The set-point value 
can be the flow, effort or power of a gate. In the parameter list of the set apparatus you choose the 
set-point variable and the gate number of the connected apparatus that you will use as a set-point. 
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Paiametei values: set 

hidex Name 

1 

2 

Value 

Up 
Add Par | 

Down 

Read file 

Write file 
Plot mat 

Unit 

Iset point                                         Ho 

jeffort(0),flow[1],power(2]               ifio 

jconnected gate nr                        ||l0 

[-] 

H 

H 

I ÄK ! Cancel 

Parameter(O): 
This parameter is the set-point value. The energy type is defined with parameter(l). 

Parameter(l): 
is the number of the set-point type. There are three types: 0, 1,2. 
set-point type 0 is the effort of the gate. 
set-point type 1 is the flow of the gate. 
set-point type 2 is the power of the gate. 

Parameter(2): 
This parameter is the gate number of the controlled gate of the connected apparatus. Running 
GES changes the par apparatuses until the set-point values of the controlled gates are 
reached. 
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3.1.3.2 par apparatus (signal type) 

,Pn- 

par 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no P [-] flow [-] 

Table 9  Gate variables par apparatus 

The par apparatus changes a parameter of the connected apparatus until the set-point value of the set 
apparatus is reached. You must always use a par apparatus and a set apparatus together. 

I Parameter values: par                                                                                                                 El 

Index Name Value                       Unit 

0        Istart parameter value 1'                        |H 
1        Iconnected parameter o                           |H 

2        1   dim parameter m: 0                 |H 
3       1   dim parameter n: 0                       |H 
4        Ivariable to workspace 0                               ][-] 

UP     1       ....      I Read file 1 p—, 
Cancel 1 .      Add Par 1 

Down   J   ■  ■         ' Write file 
Plot mat 

Parameter(O): 
Is the iteration start value of the parameter change routine in GES. It is recommended to use 
an expected value in the neighborhood of the solution. If there are more solutions you must 
choose this value properly. 
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Parameter(l): 
Is the index number of the parameter of the connected apparatus. If the parameter of the 
connected apparatus is a matrix the position in this matrix must be given by parameter(3) and 
parameter(4). 

Parameter(2): 
This value is the row number of the matrix of the parameter of the connected apparatus. This 
value is only used if the controlled parameter is an element of a matrix. 

Parameter(3): 
This value is the column number of the matrix of the parameter of the connected apparatus. 
This value is only used if the controlled parameter is an element of a matrix. 

Parameter(4): 
You can use this parameter to change other parameters of some apparatuses at the same time. 
The output value (changing parameter value) of this apparatus could be set in an internal 
global buffer of GES (indicated by a number between 0-99) or set in the global workspace 
(recommended). 

Example: 
In Figure 8 a GES example is given for changing a parameter (by the par apparatus) of the diesel 
engine until the set-point value of the set apparatus is reached. The set-point value could be the flow 
(the speed of the ship) of the gate between the Hull_Prop_Rot apparatus and the Resis. apparatus. 

fi ^—       Generator 
-^ Coil 

k£J* Hull_Prop_Rot 
Resis. 

Figure 8  Parameter changing with set- and par apparatus 

See set par example in model ges\examples\set_par.mod. 
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3.1.4 Workspace 

In this menu you can select two workspace apparatuses. These apparatuses are used to read and write 
values to and from the global workspace. Mostly these apparatuses are used to read and change 
energy- and parameter values of import library apparatuses. 
Remark: With the user defined apparatus you can easily write and read to and from the global 
workspace. In that case these apparatuses are not necessary. 

3.1.4.1 to_workspace (signal type) 

to_workspace 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no e [-] flow f [-] 

Table 1C 1  Gate va iriables to_w< orkspace app aratus 

The to_workspace apparatus is used to place energy values of a particular gate of an apparatus in the 
global workspace variables. 

Remark: A global workspace variable is a name with at least 30 characters and marked with an 
exclamation mark (!). 
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Paiameter values: to_workspace 

Index Name Value Unit 

0 

1 

2 

3 

4 

5 

6 

7 

8 

effort 

flow 
SSS'SS^SK^SSSSS??^^ 

power     > II  
dissipation 

efficiency > 

parameter > 

parameter index 

dim parameter m: 

I   dim parameter n: 

Up 

Down 
Add Par 

\ Read file 

WrHe file 
Plot mat OK Cancel 

Parameter(0): 
Gives the global variable where the effort of the inspected gate of the connected apparatus is 
set. If this value is 0 no setting is done. 

Parameter(l): 
Gives the global variable where the flow of the inspected gate of the connected apparatus is 
set. If this value is 0 no setting is done. 

Parameter(2): 
Gives the global variable where the power of the inspected gate of the connected apparatus is 
set. If this value is 0 no setting is done. 

Parameter(3): 
Gives the global variable where the dissipation of the connected apparatus is set. If this value 
is 0 no setting is done. The inspected gate value (parameter(5)) must be one of the gates. 

Parameter(4): 
Contains the global variable where the efficiency of the connected apparatus is set. If this 
value is 0 no setting is done. The inspected gate value (parameter(5)) must be one of the 
gates. 

Parameter(5): 
The inspected gate number of the connected apparatus. 

Parameter(6): 
The inspected parameter number (index) of the connected apparatus. 
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Parameter(7): 
The inspected parameter element row number if the inspected parameter of the connected 
apparatus is a matrix. 

Parameter(8): 
The inspected parameter element column number if the inspected parameter of the connected 
apparatus is a matrix. 

Import library, General library 



TNO-report 
96-CMC-R0274 

GES User's Guide version 1.05 Date Page 
December 15, 1997 75 

3.1.4.2 from_workspace (signal type) 

*<C 
from_workspace 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no P [-] flow [-] 

Table 11 Gate V8 iriables from. „workspace apparatus 

The from_workspace apparatus is used to place the value of a global workspace variable in a 
parameter of an apparatus. 
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I Parameter values: fromworkspace ES 

Index Name Value                        Unit 

0        Iname workspace [index] 1°               li- ] 
1        [connected parameter »1»             r,|i-i 
2        1   dim parameter m: 1»        |i; I 
3        1   dim parameter n: R]0                           C|H 

1                            1                1 
1                          1             M 
1                          1               1 
1                          1               1 
l ii 1 

1 _    1 _  
Un      1 Read file 

Plot mat] Add Par  | \ßf/, £ancel 
Down Write file 

Parameter(O): 
For a number this is the index of the internal global buffer of GES (indicated by a number 
between 0-99). For a global workspace variable (recommended) this must be a name followed 
by an exclamation mark. For a system workspace variable this must be a name followed by 
two exclamation marks. 

Parameter(l): 
The index of the parameter of the connected apparatus. If this parameter is a matrix element, 
the indices must be given by parameter(2) (row) and parameter(3) (column). 

Parameter(2): 
The row number in the matrix. This value is used if the parameter of the connected apparatus 
is a matrix. 

Parameter(3): 
The column number in the matrix. This value is used if the parameter of the connected 
apparatus is a matrix. 

Import library, General library 



TNO-report 
96-CMC-R0274 

GES User's Guide version 1.05 Date Page 
December 15, 1997 77 

3.1.5 Init gate (signal type) 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no I [-] flow [-] 

Table 12  Gate variables init gate apparatus 

The init gate apparatus can be used to set a gate value of an apparatus. This can be the effort or flow 
value of a gate. Because GES uses the actual gate values as the starting points for the iteration 
process this apparatus can be used as initialization for the iteration process. 
Before you use this apparatus, you must first find out which variables in the model are solved by 
iteration. You can do that by typing manually the sort numbers in the Edit menu. An automatic 
iteration list for setting this values is not worked out in GES. Therefore, you must use this apparatus 
for difficult iteration processes. 

I Create appaiatuslO Mp 
^r 

|     name |.o 
y iSiPfil ^^H 

i» 1» > 

rtcel 1 Param Create Ca 
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1 Parameter values: 10                                                                                                                   Q 

Index Name                                              Value                        Unit 

0        limit value                                      IjjO                          l|l[-]                   = 

1        |effort(0),fluw[1J                              &0                           ||[-]                  ££ 

2        linit gate number                            lllO                            Ö[-] 

I                             I                I 
I ;|                   I 
I 
I 

<fü                               |i I 

*|.^s-^^^vix^j                                                                           ■illii                                        ^HPH                               I^H 

I \\  i  
i 

i^S^SS^^HIHI ... 
Up     I                    , Read file I                 ,     " 

      Plot mat IJÖKj Cancel Add Par 
Down         ' 

Parameter(O): 
The start point value for energy solution at a particular gate. 

Parameter(l): 
The gate variable type effort or flow that is set. 0 is effort. 1 is flow. 

Parameter(2): 
The gate number of the connected apparatus where the start point value is set. 

See 3.5.3 Example; Thermodynamic cycle, page 122. 
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3.1.6 Failure module (signal type) 

m- 
Failure 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no F [-] signal - [-] 

Table 13   Gate variables failure module 

The creation dialog box for this apparatus is: 

ICreate apparatusFailure |x| 

T   name JFailure 

y l^w|S^£ 
^§^^s 

o i 1° ° 
^^^~   

| Create I Cancel 1       Param 

The failure module is a signal type apparatus and is executed after the calculation of the energy 
apparatuses. This makes it possible to change the probability failure values during the energy 
calculation. So a probability variable can be a function of an effort and or a flow variable. 
The failure module calculates the fail probability of the connected apparatus. This is the top 
apparatus. The method that is used is the "Fault Tree Analysis". The failure tree is started from the 
top apparatus and is branched by its input energy gate. There are a few rules to build a fault tree. 

A positive gate is defined as an input. In a graphical representation this is a half arrow to the 
apparatus. When building the fault tree the outputs of an apparatus are not considered. The 
tree is started from the inputs of an apparatus to the connected apparatuses. If the input is not 
connected a structure error in the parameter list of the failure module is generated. 
The fault of an apparatus is assumed to be disjunctive with its inputs and the fault must be 
less then 0.1 so the following calculation rules can be used. 
For apparatuses in series the following configuration is given: 
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For these apparatuses the following calculation is done: 

P(x) = P(f 1 or a) = P(f 1 or P(f2 or b)) = P(f 1 or f2 or b) = P(f 1) + P(f2) + P(b) 

For apparatuses connected parallel the following configuration is given: 

V = fl(a) 

fl 
a 

x = f(y en z) 

b 

c 
\                   1 o   \ 

z=f2(b) 
f2 \ \ 

The calculated probability of P(x) is: 

P(x) = P(f) + P(y) * P(z)    ;P(f)=0 (connection) 

P(y) = P(fl or a) = P(fl) + P(a) 

P(z) = P(f2 or b) = P(f2) + P(b) 

P(a) = P(c) 

P(b) = P(c) 

P(x) = (P(f 1) + P(c)) * (P(f2) + P(c)) 

Worked out: 

P(x) = P(fl) * P(f2) + P(fl) * P(c) + P(f2) * P(c) + P(c) * P(c) 
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With the reduction rules: 

P(c) * P(c) = P(c) 

P(f2) * P(c) + P(c) = P(c) 

P(x) = P(fl) * P(f2) + P(c) 

Apparatuses inside an apparatus are taken up in the fault tree if they have effect in the energy 
calculation of the apparatuses in the fault tree. Of course, these apparatuses can be a complete 
new tree. 
For instance: 

fl 

xi = ai= bi X 

fli f2i 
b 

\ \ v v \ 

P(x) = P(f 1) and P(fli) and P(f2i) and P(b) 

or 

P(x) = P(fl) + P(fli) + P(f2i) + P(b) 
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The parameter list of the failure module is: 

I Parameter values: Fail HU 
Index Name Value                        Unit 

0 (probability result 1 J0.5722                      |[] 

1 Ifail variable 

Jstructure error 

|PO_I                   |[] 

2 1°                               1 
3 i||||calculation error 1°                               1 

1 
1 
1 
1 
1 
1 

Read file j 

Write file 1 
Plot matl 

1 

OK fiancel 
Down 

Add Par  | 

•    -   ■ 

Parameter(O): (output value) 
Result of the calculation is placed in the value field. 

Parameter(l): (input string) 
The failure module calculates with the probability variable string given in the value field. The 
variable name is the expected local workspace variable that is used as the probability variable 
in the apparatuses. 

Parameter(2): (output value) 
Structure error: If the connections of the apparatuses are not correct to calculate the 
probability an 1 is set into the value field and name of the wrong connected apparatus is set in 
the unit field. 

Parameter(3): (output value) 
Calculation error: If by calculation the probability result is greater than 1 the calculation is 
stopped and an 1 is set into the value field. The name of the last calculated apparatus is set in 
the unit field. 
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Example: 

Diesel 4 

dimensions 

Fail 1 

Fail 2 

Figure 9 Example of a propulsion installation with three failure modules 
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In this example a propulsion installation is given with three diesel engines and three independent 
failure modules. Failure module Fail_l calculates the probability when the propulsion installation 
fails. Failure module Fail_2 calculates the probability of coil failure and the failure module Fail_3 
calculates the failure probability of the diesel engine group. 

Operation fault      Fail_l 

Hull fault 

Propulsion fault 

Transmission fault 

Hydraulic fault 

Diesel group 
fault Fail_3 

Fuel fault 

Ä 

Coil fault Fail 2 

Ä 
Generator 

fault 

£p* 

Figure 10 And/or fault tree for example 
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Fail_3 

Dimension 
fault 

Diesel 4 
fault 
,0 O 4^ 

Diesel 3 
fault a^ 

User fault 

Diesel 1 
fault 

Diesel 2 
fault 

Fuel fault 

Figure 11 And/or fault tree for diesel group 
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3.1.7 Run apparatus (signal type) 

Run 

input output 
gate energy variable symbol unit variable symbol unit 
0 no no r [-] flow [-] 

Table 14 Gate V£ iriables run apparatus 

The run apparatus is used to run an apparatus individually. The run apparatus runs its connected 
apparatus if its parameter control flag is set to 1. To run the connected apparatus properly it is 
recommended to run only mask apparatuses, because the mask apparatuses are not placed in the 
calculation list. 
Remark: If the connected apparatus is not a mask apparatus then this connected apparatus is running 
twice, once by the global running process and once by the run apparatus. This may give illegal 
results. 
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Parameter(0): 
The control flag for running the connected apparatus of the run apparatus. If this value is 0 
no connected apparatus is running. If this value is 1 the connected apparatus is running 
individually. You can control your application by using a global variable for the flag variable. 
Other apparatus models can change the flag variable to start and stop the connected 
apparatus. 
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Example: 
In the next figure a configuration of a run apparatus in a model is given. The flag variable in the run 
apparatus is set by an epi apparatus with name ginl. 

Figure 12  Example run apparatus configuration 

The Runl apparatus and ginl apparatus are signal apparatus types. The mask apparatus 
flex_gasturbines is running if parameter(O) of the Runl apparatus is 1. In this example this is 
indirectly set by the ginl apparatus. The ginl apparatus reads the parameter value from file and sets 
this value in parameter(O) of the Runl apparatus. 
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3.2 Electric library 

Generator standard 
Generator is a commutator machine 
Generator standard is a standard 3 phase electrical alternator 

3.2.1 Generator 

^NL—  
generator 

input output 
gate energy variable symbol unit variable symbol unit 
0 pos flow w [rad/s] effort M [Nm] 
1 neg flow i [A] effort u [V] 

Table 15   Gate variables commutator 

This apparatus describes a simple commutator machine which is operated as a generator. Its speed is 
determined by the characteristics of its prime mover. It is convenient to classify commutator 
machines as generators or motors, depending on the dominant direction of the power flow in the 
application. Commutator machines normally operate with direct voltage supplies and are usually 
referred to as direct-current machines. They are widely used in vehicles that have electric storage 
batteries, as motors for auxiliary equipment, and as starters. A major area of use for the motors is in 
the variable-speed drives where the ability to control speed and position is important. 
The relations of the ideal generator are: 

T= K I //torque (T) is linear with the current (7) 

U= K co       //voltage (U) is linear with the speed (a>) 
K = electric magnetic field constant (EMF constant) 

If we assume that for the generator U is constant and we know the efficiency T| of the generator, then 
the torque is written as: 

T = K I/T] 

The parameter list of the commutator generator is: 
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1 Parameter values: generator 13 
Index Name Value                         Unit 

0        Ivoltage eff. \AAÜ                           |[V] 

1        JEMF constant |2.3                           |rVs/rad] 

2        Irendement |0.9                           |[] 

i                                                         1                                1 
1                                                         1                                1 
1                                                      PI                             ßl 

I                                                                                                                                                                 -11111                                                                                      :ll^il                                                                :1%^S 

1             1 

ll^^^^^^^^^^B Read file 
Plot mat Add Par | ! fiK | Cancel 

Down Write file 

Parameter(O): 
The output voltage of the generator. 

Parameter(l): 
The electric magnetic field constant of the generator. 

Parameter(2): 
The efficiency of the generator. 

Example: In this example the equations are given if the generator is created with the user defined 
apparatus. First you must create a user defined apparatus with 2 gates and 3 parameters. 
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The parser string may look as follows: 

//gate (0)is mechanical side  e_gate(0)=torque 
// f_gate(0)=speed 
//gate (1)is the electric side e_gate(1)=voltage 
// f_gate(1)=current 
//parameter(0)=output voltage [V] 
//parameter(1)= EMF 
//parameter(2)=efficiency 

e_gate(0) = f_gate(1)*parameter(1)/parameter(2); //torque T 

neg_gate(1); 
e_gate(l) = parameter(0);  //output voltage U 

See apparatus commutator in model ges/examples/comu_tor.mod. 

In Appendix B Parser equations of an asynchronous machine, page 214 an example is given of an 
asynchronous machine. See apparatus asynchrone in model ges/examples/asynaand.mod. 
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3.2.2 Generator standard 

input output 
gate energy variable symbol unit variable symbol unit 
0 pos flow w [rad/s] effort M [Nm] 
1 neg flow i [A] effort u [V] 

Table 16  Gate variables standard generator 

This apparatus describes a standard three-phase industrial electrical alternator. 

Efficiency of the standard alternator 
For this apparatus the load dependent efficiency curves for standard alternators are given as 
polynomial formulas. For each speed an efficiency curve for a larger powered alternator (upper 
curve) and a lower powered alternator (lower curve) is given. For calculation of the efficiency of 
alternators with a power size between the upper and lower curve an interpolation according to the 
cube root will be executed. Also extrapolation of power sizes until 10 % above the upper curve and 
10 % below the lower curve can be executed according to the cube root. 

Example of interpolation calculation: 

Asked: efficiency at 50 % load of a 1200 rpm alternator of 4000 kW 

Calculation:      efficiency of a 1200 rpm, 6150 kW alternator at 50 % load is 
according to the formula 95.5 %. 
efficiency of a 1200 rpm, 350 kW alternator at 50 % load is 
according to the formula 91.5 %. 
efficiency of a 1200 rpm, 4000 kW alternator at 50 % load can be calculated 
with: 

,4000-350 
V 6150 -350 

Creating the generator 
If you click on Create in the create dialog box you must first define the total number of coefficients 
of your alternator efficiency-load curves. The dialog box is: 
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Polynoom 

: Input number coefficients: 

OK Cancel 

This number is the number of rows of parameter(3) and parameter(5) in the parameter list of the 
standard generator. 

Parameter values: generator " HBBHHHii] 
Index Name Value Unit 

I 
0        Ivoltage eft. \AAQ |M 

1        Igenerator power |1000 |[kW] 

2        jupper powerline liooo |[kWI 

3        I                      ndement] upper ■matrix[3][2] |HH 
^        llower powerline |1000 |[kW] 

5        I                      ndement] lower |matrix[3][2] |HH 

i*^           ji         n 
i                   i           i 
i                   i           i 

I 

Plot matl 
Up     1                           Read file . —_——_—_ 

,™_ 

Cancel! Add Par        . ...   . __     ' 
uown         "™" "~"" )    Write file • - ' ■ ■ '      I 

"BT~<rr:rww' 

Parameter(O): 
The effective output voltage of the standard generator. 

Parameter(l): 
The nominal power of the generator. 

Parameter(2): 
The nominal power of the maximum (upper) given generator. 

Parameter(3): 
Contains the coefficients of the load and efficiency in fractions of the upper power line. 
The load fraction is the actual power divided by the nominal power and is placed in column 
1. The efficiency (fraction) is placed in column 2. 
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Parameter(4): 
The nominal power of the minimum (lower) given generator. 

Parameter(5): 
Contains the coefficients of the load and efficiency in fractions of the lower power line. 
The load fraction is the actual power divided by nominal power and is placed in column 1. 

The      efficiency (fraction) is placed in column 2. 

An example of the lower and upper curves are given in the next figure. 
The efficiency is given in per cent. In parameter(3) and parameter(4) you must insert the fraction! 

efficiency % 
100 

95 

90 

85 

80 

75 

70 
0 0.25 0.5 0.75 1.0 1.25     load 

Figure 13  Example lower and upper curves alternator 

Example: The efficiency curves of the standard alternator are given as polynomial formulas. 
First you must create a user defined apparatus with two gates and five parameters. 

^J y.                  4 1 1 1 ■ —i 

>^ 
—♦—upper line % 

—■— lower line % d*-^ fZ-  
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The parser string may look as follows: 

// Shaft generator 900 rpm = 94.2477 rad/s for all voltage 
// gate(0) input mechanical energy e = torque[Nm] 
// f = speed[rad/s] 
// gate(l) output electric energy e = voltage[V] 
// f = current[A] 
// parameter(0) = output voltage alternator [V] 
// parameter(1) = not used 
// parameter(2) = normal load of the alternator in kW 
// parameter(3) = normal load of the upper alternator in kW 
// parameter(4) = normal load of the lower alternator in kW 

name_parameter(0)'voltage'; 
unit_parameter(0)'[V]'; 

name_parameter(2)'normal load alternator'; 
unit_parameter(2)'[kW]'; 

name_parameter(3)'normal load upper curve'; 
unit_parameter(3)'[kW]'; 

name_parameter(4)'normal load lower curve'; 
unit_parameter(4)'[kW]'; 

power = e_gate(1)*f_gate(1)/1000; //actual electric power kW 
win  = f_gate(0); //actual speed in rad/s 

pu   = power*94.2477/(parameter(2)*win);   //load fraction 

//polynomial curves of the upper and lower lines 
//efficiency % of the upper alternator example 
eff_max = -6.97*puA2 + 13.5*pu + 90.4; 

//efficiency % of the lower alternator example 
eff_min =  8.53*puA3 - 27.8*puA2 + 28.5*pu + 83.1; 

eff = eff_min + ((parameter(2)-parameter(4)) / 
(parameter(3)-parameter(4)))A(1/3) * 
(eff_max-eff_min); 

eff = eff / 100;  //efficiency fraction of the actual alternator 

e_gate(0)   = power * 1000 / (win*eff);  //torque shaft 

neg_gate(1); 
e_gate(l)   = parameter(0);  //output voltage alternator 

See alternator in model ges\examples\altenatr.mod. 
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3.3 Mechanical library 

3.3.1 Diesel simple 

W 

diesel 

3^dm/dt 

input output 
gate energy variable symbol unit variable symbol unit 
0 neg effort M [Nm] flow w [rad/s] 
1 pos effort h [Kj/kg] flow dm/dt [g/s] 

Table 17  Gate variables Diesel simple 

This apparatus describes a simple diesel engine with constant torque over a wide speed range. The 
power equation of this engine is: 

Too =rj h m 

m 
= fuel consumption 

T is the engine torque [Nm] 
co is the actual speed [rad/s] 
h is the enthalpy of the fuel [J/kg] 

m is the mass flow of the fuel [g/s] 
T] is the efficiency [-] 

torque % 
100 

80 

60 

40 

20-I 

0 
n min n max speed 

Figure 14  Torque speed characteristics of the diesel engine 

100% injection 
75 % injection 
50 % injection 

•K— 25% injection 
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For this model we assume that the efficiency rj over the speed range is constant. The minimum and 
maximum speed of the diesel engine is not taken into account. 

Parameter values: diesel 

Index Name 

|Up 
Add Par 

Value 

Read file 

Write file 
Plot mat 

Parameter(O): 
The actual speed of the diesel engine in rad/s. 

Parameter(l): 
The fuel consumption of the diesel engine in g/kWh. 

Unit 

Ivplnritv                                                    ll nil iveiociiy                                                  jiuu 

(specific                                         IlPlS 

1     .    1 
1  j 

  1 .1 

J                            1 
1 Ji 
1                        M 
1 

IrraHJQl j|Lrauls»J 

feSwhl 

OK fiance! 
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Example: 
You could also create this apparatus with the user defined apparatus. The parser equations for this 
simple model are: 

//gate(0)is fuel input power, e_gate(0)=h, f_gate(0)= mass //flow 
//gate(1)is mechanical output power ; e_gate(1)=T,f_gate(1)=w 
//parameter(0) is actual speed in rad/s 
//parameter(1) is fuel consumption in g/kWh 

neg_gate(1); 
f_gate(l) = parameter(0); 
//actual speed [rad/s] 

f_gate(0) = e_gate(l) * parameter(0) * parameter(1) / 36e5;  //fuel 
mass flow [g/s] 

See u-diesel apparatus in model ges\examples\u_diesel.mod. 
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3.3.2 Diesel exhaust 

dm/dt 

input output 
gate energy variable symbol unit variable symbol unit 
0 neg effort M [Nm] flow w [rad/s] 
1 pos effort e [kJ/kg] flow NOx [g/s] 
2 pos effort e [kJ/kg] flow HC [g/s] 
3 pos effort e [kJ/kg] flow CO [g/s] 
4 pos effort e [kJ/kg] flow S02 [g/s] 
5 pos effort e [kJ/kg] flow C02 [g/s] 
6 neg effort h [kJ/kg] flow dm/dt [g/s] 
7 neg flow 02 [g/s] 
8 neg flow N2 [g/s] 
9 neg flow H20 [g/s] 
10 pos flow AIR [g/s] effort e [kJ/kg] 

Table 18   Gate variables diesel exhaust 

For the description of this apparatus see User's Guide version 1.05 reference [2]. 

The diesel_exhaust apparatus replaced the diesel_emissie apparatus of GES version 1.00. 
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Create apparatus: diesel exhaust 

name 

x 

jdiesel exhaust 

■HHIMHI 
0 

Create j        Cancel I       Param 

By creation of this apparatus the default values are read from the file GESEM.PAR that must be in 
the directory C:\GES\DATA. This file contains the default values of the SW280pr diesel engine. 

The parameter list of the diesel_exhaust apparatus is: 

Parameter values: diesel exhaust 

Index Name Value Unit 

0 

1 

2 

3 

A 

5 

6 

7 

Actual speed 188 

Nominal speed 1800 

|[rad/s] 

|[c/min] 

Min speed limit 408 

Nominal power 1200 

||[c/min] 

|[kW] 

C in fuel 86 

H2 in fuel 13 

S in fuel 

Aspect values 

Calculation values 

[i [j%f 
|matrix[4][8] ;  pf 

|matrix[11][1] [FT 

Up 

Down 
Add Par 

Read file | 

Write file | 
Plot mat pasi Cancel 

Parameter(0): 
Actual speed of the diesel engine. 

Parameter(l): 
Nominal speed of the diesel engine. 
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Parameter(2): 
Minimum speed limit. 

Parameter(3): 
Nominal power. 

Parameter(4): 
Percentage carbon in fuel. 

Parameter(5): 
Percentage hydrogen in fuel. 

Parameter(6); 
Percentage sulfur in fuel. 

Parameter(7): 
A matrix that contains the aspect values of the 
matrix[0][0]: nominal fuel consumption 
matrix[l][0]: nominal emission ratio NOx 
matrix[2][0]: nominal emission ratio HC 
matrix[3][0]: nominal emission ratio CO 

Parameter(8): 
Is a matrix that contains calculation values. 
matrix[0][0]: equivalence ratio [-]. 

matrix[l][0]: HC-ratio 
matrix[2] [0]: fuel consumption 
matrix[3][0]: emission ratio NOx 
matrix[4][0]: emission ratio HC 
matrix[5][0]: emission ratio CO 
matrix[6][0]: emission ratio S02 
matrix [7] [0]: emission ratio C02 
matrix[8][0]: emission ratio 02 
matrix[9][0]: emission ratio N2 
matrix [10][0]: emission ratio H20 

diesel engine, 
[kg/h] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 

If gate 10 is not connected this value is an 
input parameter. The air flow is 
automatically calculated. 

Default value is 2. 
[-] Default value is 2. 
[kg/h] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 
[g/kg fuel] 

Remark: 
The results of the program Mossel are set in the file GESEM.DAT in the startup directory of Mossel. 
With the program Mos_ges.exe the results from the file GESEM.DAT are translated to a GES 
parameter format. The results are set in the file MOSSEL.PAR you can read this file, by pressing on 
<Read file> button in the parameter list. 
It is recommended to start the program Mossel from GES tools, because the program is started by a 
batch file Mossel.bat. See 2.3.7.2 Mossel (Tools menu), page 49. 
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3.3.3 Transmission 

This apparatus describes a simple general transmission. The speed transmission is assumed to be 
constant and the torque loss is only dependent of the efficiency factor. The power equations of this 
model are: 

if 

then 

<»«* = n a» 

Tin = Tou, n/T] 

Toul   = output torque [Nm] 
Tin    = input torque [Nm] 
n = ratio [-] 
rj = efficiency [-] 
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Parameter values: transm. 

Index Name 

0 

1 

Up  I 
"".""l-,""l       Add Par 

Down            ' 

Value 

Read file 

i Write file 
Rot mat 

unit 

(transmission                                   jl 

(efficiency                                         |1 

H 

H 

i  OK  i Cancel 

Parameter(0): 
The transmission ratio n. 

Parameter(l): 
The efficiency rj. 
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3.3.3.1 Gearbox 

This apparatus is not implemented in the import library. 
In practice the efficiency of a gearbox is dependent of the part-load. A more detailed model of a 
gearbox is described here. The following example provides a design for a gearbox with the user 
defined apparatus. 

For the off-design of gearbox losses it is assumed that part of the loss is proportional to the 
transmitted power, that another part is proportional to the transmitted torque and that the balance is 
proportional to shaft speed. 
The equation of the loss of power by part-load is described with the following equation: 

PPM loss    = a—iJL- + b—-& 
loss,norm M,. 

■+e-A. 
N:_ 

Ploss  is als0: 

P        =P    -P loss in out 

If the ratio n of the gearbox is known, the output speed of the gearbox is: 

N    =n N iyout       n lyin 

Practical values for the fractions a, b and c are: 0.4, 0.4, 0.2. See reference [5]. 

If the input speed and the output torque are known, the output speed and input torque can be 
calculated with the equations given in the following parser string: 

//gate(0) input e_gate(0) = M_in f_gate(0) = N_in 
//gate(l) output e_gate(l) = M_out f_gate(l) = N_out 
//parameter (0) = ratio of the gearbox (N_out/N_in) 
//parameter(1) = Ploss_norm 
//parameter(2) = Nin_norm 
//parameter(3) = Min_norm 
//parameter(4) = a 
//parameter(5) = b 
//parameter(6) = c 

name_parameter(0)'ratio'; 

name_parameter(1)'Ploss_norm'; 
unit parameter(1)'[W]'; 
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name_parameter(2)'Nin_norm'; 
unit_parameter(2)'[rad/s]'; 

name_parameter(3)'Min_norm'; 
unit_parameter(3)'[Nm]'; 

name_parameter(4)'a' ; 
name_parameter(5)'b'; 
name_parameter(6)'c'; 

//functions for output speed 
neg_gate(l); //gate(l) is the output 
f_gate(1)=parameter(0)*f_gate (0); 

//xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
//functions for the input torque 
P_out= f_gate(l)*e_gate(l); //W 
N_in = f_gate(0); //rad/s 

Ploss_norm = parameter(1) 
Nin_norm = parameter(2) 
Mi_norm = parameter(3) 
Pin_norm  = parameter(4) 

aa = parameter(5); //0.4 
bb = parameter(6); //0.4 
cc = parameter(7); //0.2 

//do not use Min_norm. This gives 
//parser error: ( expected 
//is bug because min is a function 

M_in = ((P_out/Ploss_norm) + (cc*N_in/Nin_norm)) / 
((N_in/Ploss_norm) - (aa*N_in/Pin_norm) - (bb/Mi_norm)); 

e_gate(0) = M_in; 

See apparatus gear in ges\examples\gear.mod. 

For a another combination of input variables you must rewrite the equations. 
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3.4 Hydraulic library 

The hydraulic library consist of four groups. 

Pipe resistance lambda 
Pipe resistance Re 
Pipe resistance CW 

Pump is an entry to a variable hydraulic motor and generator 
Pipe resistance lambda is a general pipe resistance 
Pipe resistance Re is for Reynolds < 2300 
Pipe resistance CW is for Reynolds > 2300. 

3.4.1 Hydraulic-motor 

hyd. motor 

ql 

input output 
gate energy variable symbol unit variable symbol unit 
0 pos flow qh [m3/s] effort Ph [N/m2] 
1 neg effort PI [N/m2] flow CO [rad/s] 
2 neg effort M [Nra] flow ql [m3/s] 

Table 19  Gate variables hydraulic-motor 

qh is the driving flow in the high pressure pipe. 
ql is the return flow in the low pressure pipe. 
co is the motor speed. 
M is the motor torque. 
Ph is the pressure in the high pressure pipe. 
PI is the pressure in the low pressure pipe. 

Because P = Ph-Pl, Q = qh the equations of the hydraulic-motor are: 

6) 
1 Ys 

a qO     a2 q02 

1 
0 

aqO 

Q 

M + M0 

The general hydraulic motor is adjustable with a. 
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Mo is the starting torque of the motor. 
qO is the transmission. Practically qO = ß™«/ öu . 
Ys is the flow conductance. This factor is depending on the leakage of the motor. A practical value is 
3%. So a value for Ys is for instance Qmax 3% / Pmax 

I Parameter values: hyd motor 
iiiiiiiimiiu IIIIHHIIHIUIIIIIII.IIM uiiiiiiuinimii iiiiiiHiiiiiimiinimiiimiiiironmiiMiiiiiiMii 

Hx| 
Index Name Value                        Unit | 

0        IVariable .. h            In 
1        |Qo fl8e-05                       |[r n*3/rad] 

nA3/bar s] 2        |Ys |le-11                       |[r 

3        |M0 I250                          1^ Jm] 

1                                1 
1                                                           1                                 1 
1                                                      1                                 1 
1       1                    1 
1                                                           1                                 1 

1   __          1        
l:^^^i^^^^^^^H Read file 

Plot mat Add Par  | } fiK £ancel 
Write file 

Parameter(O): 
Is the transmission factor a. 

Parameter(l): 
Is the transmission ratio qO. 

Parameter(2): 
Is the leak conductance Ys. 

Parameter(3): 
Is the starting torque MO. 
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hyd.generator 
qi 

input output 
gate energy variable symbol unit variable symbol unit 
0 pos flow CO [rad/s] effort M [Nm] 
1 neg effort Ph [N/m2] flow qh [m3/s] 
2 neg effort PI [N/m2] flow ql [m3/s] 

Table 2C 1 Gate va iriables hydrt xulic-generat or 

qh is delivery flow in the high pressure pipe. 
ql is the source flow in the low pressure pipe. 
co is the generator speed. 
M is the generator torque. 
Ph is the pressure in the high pressure pipe. 
PI is the pressure in the low pressure pipe. 

Because P = Ph-Pl, Q = qh the equations of the hydraulic-generator are: 

Q 

M 

aqO -Ys 

0     aqO 

r       -i r          -i 

CO 

+ 
0 

p MO 
L     J L      J 

The general hydraulic generator is adjustable with a. 
Mo is the starting torque of the generator (Coulomb resistance). 
qO is the transmission. Practically you can use qO = Qmax/cOmax ■ 
Ys is the flow conductance. This factor is depending on the leakage of the generator. A practical value 
is 3%. So a value for Ys is for instance Qm^ 3% / Pmax 
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Parameter values: hyd. generator 

Index Name Value 

0 

1 

\Z\ 

^3 

Up 

Down 
Add Par 

Read file 

Write file 
Rot mat 

Date Page 
December 15,1997 109 

Unit 

IVariable                                             |1 

JQo                                                )|?e-05 

JYs                                                      |1 e-11 

MO                                                     |250 

I                             I 

H 

[m*3/rad] 

[m*3/bar s] 

[Nm] 

f OK i Cancel 

Parameter(O): 
The transmission factor a. 

Parameter(l): 
The transmission ratio qO. 

Parameter(2): 
The leak conductance Ys. 

Parameter(3): 
The starting torque MO. 
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3.4.3 Pipe resistance lambda 

Pi 

7dt 
//dt pipe_Re 

input output 
gate energy variable symbol unit variable symbol unit 
0 pos flow dV/dt [m3/s] effort Pi [N/m2] 
1 neg effort Pu [N/m2] flow dV/dt [m3/s] 

Table 21 Gate vz iriables Pipe resistance la mbda 

This apparatus can be used to described pipe resistance in the following form: 
The usual expression for pipe resistance is: 

2dH 

v is velocity of the liquid flow [m3/s] 
p is density [kg/m3] 
/ is length of the pipe [m] 
d is diameter of the pipe [m] 
X is resistance constant [-] 

The resistance constant X depends of the Reynolds constant Re. 
Re is defined as: 

Re = ^I   or   Re = ^ 
ri v 

T] = dynamic viscosity [Ns/m ] 
v = kinematic viscosity [m2/s] 

In GES the flow variable is expressed in m3/s. The effort variable is the pressure ÄP. Then the effort 
variable is written as: 

e = 
Xpl 

2d A' 1/1/ 

To determine X two area's must be discerned. 
- laminar flow: Re < 2300 
- turbulent flow: Re > 2300 
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For creating a pipe resistance the following dialog box is displayed. 

Create apparatus.pipe lambda 

name 

ix 

pipelambda 

HMHHI 

■ Create Cancel Param 

If the apparatus is created, the following parameter values are displayed by clicking Param. 
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